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Getting Started 

Welcome 
 
Welcome to Messenger Pro, an advanced multi-platform messaging client that provides powerful 
facilities for managing electronic mail and news from multiple sources. 
 
Note that certain features may be unavailable depending on which edition of Messenger Pro you 
have purchased. 
 

The Main Window 
 
Once installed, Messenger Pro will open its main window which consists of a group hierarchy on 
the left, listing all groups that Messenger Pro currently knows about, a group viewer at the top-
right, which can display the contents of a group, and a message viewer which can display a single 
message.  By default, these three appear in a single window but groups and messages can be opened 
in their own windows if required.  Alternatively, this window can be split into three right from the 
start (or two – a combined hierarchy and group viewer window and separate message windows) 
which is the style this manual will use in order to describe features specific to each of these 
different viewers without other features getting in the way.  Configuring the way these windows 
work is described later in this manual. 
 

 
 
The following sections of this manual will describe the parts of this window in more detail. 

Online Help 
 
If at any time you need assistance when using Messenger Pro, this manual can be opened from the 
main window by selecting User Manual from the Help menu. 
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Terminology 
 
Messenger Pro and this manual use a specific set of terminology which is described here for your 
reference. 
 
Account 
A source of mail or news or a means of sending messages that you write.  An account is usually set 
up for you by your ISP or network administrator and exists on a server for which you are given 
login details (although not always) in the form of a user name and password.  Messenger Pro 
supports POP3 and IMAP mail accounts and NNTP news accounts.  It also supports SMTP for 
sending mail. 
 
Identity 
You may have more than one e-mail address, for instance a work address and a home address, and 
possibly more if you have affiliations to other organisations.  Mail sent to each of these addresses 
may originate from different accounts but it’s generally more convenient to handle them in one 
place.  Messenger Pro allows you to create a separate identity for each one and automatically 
handles the issue of selecting the right identity to use when responding to a message sent to a 
particular identity. 
 
Message 
A message is a single communication that you have downloaded from an account or wish to send 
yourself.  It can be either an e-mail or a newsgroup posting. 
 
Group 
A group is a storage location for messages and usually consists of messages that have something in 
common.  Messenger Pro further divides groups into mailboxes, folders, newsgroups and mailing 
lists but group is the collective name used to refer to all of these types. 
 
Mailbox 
A mailbox is a group containing e-mail messages downloaded from a mail account. 
 
Inbox 
Your inbox is where most of your incoming e-mail will go, unless you have instructed Messenger 
Pro otherwise.  You have a single inbox for all your POP3 accounts, but online IMAP accounts will 
have their own separate inboxes corresponding to the inbox that exists on the remote IMAP server. 
 
Folder 
A folder is a group which can contain any type of message.  Typically, you will create a set of 
folders for different purposes, named appropriately, and move messages to those folders for future 
reference. 
 
Newsgroup 
A newsgroup is a group containing news postings.  Each newsgroup exists on news servers around 
the world and the newsgroup you see in Messenger Pro reflects the messages available on all the 
news servers you have told Messenger Pro about by setting up news accounts. 
 
Mailing List 
A mailing list is a folder containing mail from a mailing list.  Messenger Pro allows you to filter 
mailing list messages into a separate folder which is then specifically displayed as a mailing list. 
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Filter 
A set of rules for identifying messages with certain properties and indicating what Messenger Pro 
should do with them.  Filtering may colour messages, change their status (read, flagged, etc.) or 
redirect messages to a different folder, etc. 
 

The Group Hierarchy Viewer 
 
We begin our tour of Messenger Pro by looking at the group hierarchy viewer.  This is Messenger 
Pro’s main window and can either be displayed on its own or with a group and message viewer 
appearing as separate panes (which is the default).  It displays a list of all your groups, arranged into 
a hierarchy to make the list more manageable.  At the bottom it also displays the current status of 
Messenger Pro with respect to any operations in progress and whether or not there is any new mail 
just received or waiting to be sent. 
 

 
 

The Hierarchy 
 
Most of your groups will appear under the Local folders heading.  This includes the following 
groups: 
 

 Inbox – your received mail 
 Outbox – mail and news waiting to be sent 
 Sent mail – saved copies of mail you’ve sent 
 Sent news – saved copies of news you’ve sent 
 Waste basket – deleted messages 
 Drafts – messages you’ve edited and saved but haven’t sent yet 
 Junk – junk messages filtered by junk filtering rules 

 
There are separate headings for your Mailing Lists and Newsgroups.  In addition, if you have any 
online IMAP accounts set up, then a separate heading will appear for each account, with all folders 
belonging to that account appearing beneath its heading.  You can also place groups beneath other 
groups in the hierarchy by dragging with the mouse to create a parent/child relationship between 
your groups; Messenger Pro will then only display those groups when that part of the hierarchy has 
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been expanded.  Where a group has child groups it will have a + shown next to it which can be 
clicked to expand the hierarchy, at which point it will change to a – to indicate that clicking again 
will contract it.  Note that IMAP folders can only be made children of other IMAP folders 
belonging to the same account and not any other kind of folder, and similarly non-IMAP groups 
can’t be made children of IMAP folders. 
 
Next to each group is a count of the messages in the group; this is shown in the format 
[unread/total]* (flagged) where unread is the count of unread messages in the group, flagged the 
number of flagged messages, and total the count of all messages in the group.   If there aren’t any 
flagged messages then the flagged count won’t appear while the square brackets [ ] around the 
count will only appear if new messages have arrived since the last time you opened the group.  The 
asterisk *, if present, indicates that the group’s counts include the counts of its child groups. 
 
By default, only groups containing unread messages will be listed, unless a particular group has 
been configured to be displayed all the time.  In general, folders will always be listed so you can 
access them easily, and newsgroups/mailing lists will be hidden if they only contain read messages, 
but this can be configured on a per-group basis.  The option Show Unread/All Groups on the View 
menu can be used to toggle the current display setting. 
 
Groups can be selected by clicking with the mouse allowing operations to be performed on them.  If 
the window also shows a group viewer pane then clicking on a group will display it in the viewer; 
double-clicking will open the group in a separate window. 
 
Folders can be renamed by clicking on their name which makes the name writable and allows a new 
name to be entered, or by selecting the folder and choosing Rename Folder from the Edit menu. 
 

Creating Folders 
 
New folders can be created by selecting Folder from the New submenu of the File menu; the create 
folder dialogue will then appear. 
 

 
 
The group hierarchy is shown at the bottom of the dialogue, allowing you to select a group you 
want to Create the folder as a child of.  The actual name of the folder is entered at the top as the 
Folder name.  Clicking OK will create the folder with the specified name and location in the 
hierarchy. 
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The Group Selector 
 
The group selector is a modified version of the create folder dialogue and allows a selection of 
groups to be made.  Messenger Pro will use a group selector whenever it needs to ask you for a 
selection of groups for it to use for a particular operation. 
 

 
 
Simply select the groups you want to use by clicking on them with the mouse (holding down Ctrl to 
select more than one group or Shift to select a range of groups) then click OK to complete the 
selection.  If you want to use a new folder, the Create button can be used to create one with a 
default name (e.g. New Folder 1); clicking on it will then allow it to be renamed. 
 

Searching Messages 
 
If you are having trouble finding a particular message somebody has sent you, you can have 
Messenger Pro find it for you using its search facilities.  These are also useful if you want to tidy 
your folders, since you can search for all messages that have something in common and delete them 
or move them to another folder.   
 
The search dialogue is opened by selecting Search Messages from the Edit menu.  It allows all 
your groups to be searched for messages sent to or from a particular person, on a certain date or 
with specific words in the message.  You select your Search groups at the top which controls 
which groups Messenger Pro will search for you.  By default it will only check your Inbox, or the 
group that was selected when you opened the dialogue, but this can be changed by clicking Change 
and selecting the desired groups from the group selector. 
 
You then need to tell Messenger Pro What To Look For.  The following fields are available: 
 

 From – the sender of the message 
 To – who the message was sent to 
 Subject – the subject of the message 
 Message – the actual content of the message 
 Sent after – messages sent after a particular date 
 Sent before – messages sent before a particular date 

 
Next to each field is a check box which will be automatically checked when something is entered in 
that field.  Only those fields that are checked will be included in the search, so if you enter 



Messenger Pro User Manual 
 

 
9 

something but then change your mind and want to exclude that field from the search, simply 
uncheck the check box.  For a message to be found, it must satisfy all the fields that you’ve entered.  
You can also specify that found messages must be Read, Replied, Flagged or contain 
Attachments by either checking or clearing these fields;  note that the default for these fields is 
unspecified matching all messages regardless of message status. 
 
As an alternative to entering search criteria, you can Use a Predefined Filter which allows you to 
use Messenger Pro’s filter matching capabilities to define a more powerful search.  Filters are 
explained in a later section of this manual.  To use one, select the desired filter from the Use filter 
combo box.  If you need to edit or create a filter first, clicking Filters will open the filter manager 
from where you can do this. 
 

 
 
Once your desired criteria have been entered, clicking Search will begin the search and display a 
list of matching messages at the bottom of the dialogue.  From here you may double-click a 
message to open it and a pop-up menu can be brought up by right-clicking which allows you to 
perform any of the usual message operations (described later) on the messages it has found.  The 
Clear button will clear the results pane if you want to perform any additional searches; otherwise 
the results of all searches will be listed together. 
 

Group Subscription 
 
Newsgroups must be subscribed to before they will be downloaded.  Similarly, you also need to tell 
Messenger Pro which IMAP folders you want to access.  This is done using the group subscription 
window which differs slightly between newsgroups and IMAP folders.  The newsgroups version is 
opened by selecting Newsgroup Subscription from the Tools menu; the IMAP version is opened 
using IMAP Folder Subscription.  Since the IMAP version is the simpler of the two, the 
newsgroup version will be described here. 
 
The main part of the window contains three tabs allowing you to view all, subscribed or new 
newsgroups.  All newsgroups allows you to see a full listing of newsgroups available on all the 
news servers you have set up accounts for, Subscribed newsgroups lists only the newsgroups to 
which you’re already subscribed and New newsgroups lists any recently created newsgroups.  The 
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groups are shown in a hierarchy based on their names (e.g. all newsgroups that start comp. are listed 
underneath comp) which can be expanded by clicking the + button next to each name, and each line 
lists a newsgroup name and a description of the newsgroup, if this is made available by the server.  
Unsubscribed newsgroups are shown with faded icons and subscribed newsgroups with full (i.e. 
non-faded) icons.  Subscribing to a newsgroup is a simple matter of selecting it and clicking 
Subscribe while unsubscribing is done by clicking Unsubscribe; double-clicking a newsgroup will 
toggle its subscribed status.  You can also enter the newsgroup name manually and click Add. 
 
If you want to find newsgroups on a certain subject then you can Display newsgroups which 
contain a particular piece of text in their name or description.  Simply enter the text, click Show 
and Messenger Pro will only list those newsgroups containing that text.  If you want to download 
the list again then clicking Refetch List will clear the current list and download it again 
immediately from all your news accounts.  You can also Catch Up new newsgroups which will 
remove them from the New newsgroups tab. 
 

 
 

The IMAP version is similar but contains fewer options since new folder listings aren’t available. 
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Transfer Status 
 
If any transfers are currently in progress then the online/offline indicator in the status bar at the 
bottom of the window will show the number of current connections in brackets in this indicator; for 
example, Online (2) indicates two connections that are currently active.  Messenger Pro can be 
forced to go offline by right-clicking this indicator and choosing Online or Offline from the pop-up 
menu.  Note that under Windows this controls the system wide online/offline setting as used, for 
example, by Internet Explorer.  No transfers will take place when Messenger Pro is offline. 
 
Double-clicking this indicator will allow you to see the current status of transfers in more detail.  
You can also open this window by selecting Transfer Status from the View menu. 
 

 
 
For each active transfer, the account name and type is shown, along with a one line status indicator 
which describes the current state of the transfer.  Transfers can be stopped prematurely by clicking 
the Stop button. 
 
If any errors occur during a transfer, the online/offline indicator icon will change to include an 
exclamation mark !.  The errors can be listed by clicking Show Errors from the transfer status 
window which opens another window listing all errors, the accounts that they relate to and the date 
and time at which they occurred.  Clicking Clear All will clear this list while Copy All can be used 
to copy the errors to the clipboard, perhaps to assist with reporting problems. 
 

 
 

Transfer errors and other information will also be logged to a file which you can view by selecting 
the Global Log option from the View menu.  
 
Normally, message transfers will take place automatically every so many minutes, but they may be 
started manually by selecting Send and Receive All from the Send and Receive submenu of the 
Tools menu.  This will force all accounts to do an immediate transfer.  You can also Send and 
Receive Mail, Send and Receive News, Send All or Receive All, to transfer only mail, only news, 
only sent messages and only downloaded messages respectively.  You can also transfer messages 
only to and from a specific account by choosing it from the Account submenu. 
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The Waste Basket 
 
Rather than delete messages or folders straightaway, whenever you delete anything it will instead 
be placed in the waste basket.  This means that, should you later realise that you need something 
you’ve deleted, or if you’ve deleted something by mistake, you’ll find it in the waste basket from 
where you can open it and/or copy it back to where it came from. 
 
The contents of the waste basket are automatically deleted after 3 days (configurable in the group 
options for the waste basket), but the entire contents of the waste basket can be manually deleted by 
selecting Empty Waste Basket from the Edit menu. 
 
Note that IMAP folders and the messages stored within them are unable to use the waste basket. 
 

Tidying Old Messages 
 
Old messages are automatically deleted after a certain number of days during a process called a 
tidy.  Newsgroup and mailing list messages are typically deleted after 14 days, whereas messages in 
most folders aren’t deleted unless Messenger Pro is explicitly asked to, but this is configurable on a 
per-group basis. 
 
Tidying will happen automatically once each day at midnight, if Messenger Pro is running at the 
time, or at the first opportunity thereafter.  However, a manual tidy can be initiated by selecting 
Tidy Old Messages from the Tools menu, which may be useful if you change the tidy settings and 
want them to take immediate effect. 
 

Editing Group Properties 
 
The properties of a group can be edited by selecting the group and choosing Properties from the 
File menu, or by right-clicking on the group and choosing Properties from the pop-up menu.  The 
group properties editor has four tabs allowing different group settings to be altered. 
The Display tab contains options that control how a group’s messages are displayed.  Normally a 
group is displayed showing only unread messages, i.e. those messages that you haven’t seen yet.  
For newsgroups and mailing lists this is usually how you’ll want to read the group since you’ll 
rarely want to access old messages (but may still do so if you need to).  However, for mailboxes and 
folders you will probably want to see all messages in which case you can enable the Show both 
read and unread messages option for the group.  You can also Hide messages marked for 
deletion which is useful for IMAP folders where messages are marked for deletion but expunged 
later by some other process, so they no longer show up when you go into the folder. 
 
Messenger Pro can display a group in two ways: one is a simple flat listing of all messages in the 
group, whereas the other is a grouping of all messages which can be done in various ways.  The 
Message Grouping option controls how messages are grouped together, if at all, allowing selection 
from a number of different groupings.  The first is No grouping which is the default for mailboxes 
and folders, whereas the default for newsgroups and mailing lists is Group into threads, which 
threads messages into conversations, grouping together all messages on a certain topic with replies 
appearing beneath their original messages.  The remaining options are to Group by date, Group 
by sender, Group by recipient, Group by newsgroup, Group by account and Group by group. 
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Finally, a list of columns is shown, each representing a different field of information, from which 
you can choose which ones you want to see.  A checked checkbox indicates which are currently 
selected and placing a check in an unselected column will move the named column up to join the 
rest of the selected columns.  The ordering can then be controlled by selecting a column and 
clicking Move Up to move it up the display and hence in the column ordering, or Move Down to 
move it down.  You can also choose which column will be sorted on, and whether in ascending or 
descending order, by selecting it and clicking Sort Ascending or Sort Descending.  Note that each 
successive selection will demote the currently selected sort criteria, hence allowing a multi-level 
sort to be defined; the number shown reflects the order in which the criteria will be applied. 
 
The available columns are: 
 

 Account – the account the message was downloaded from or sent to 
 Attachments – an icon indicating which messages have attachments 
 Downloaded – an icon indicating header only or full messages 
 Flagged – an icon indicating flagged messages 
 From – the name of the person who sent the message 
 Group – the group the message belongs to 
 Identity – the e-mail address that originated the message 
 Importance – an icon indicating if the message has high or low importance 
 Junk Probability – the probability that the message is junk.  Note that enabling this option 

will slow down Messenger Pro as a lot of calculations are involved, so its use is only 
recommended temporarily for diagnostic purposes. 

 Locked – an icon indicating if the message is locked 
 Message Number – Messenger Pro’s internal message number, allocated sequentially as 

messages are added to the group 
 Newsgroups – the newsgroups the message was posted to 
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 Original Group – for a message in the waste basket, the group the message was deleted 
from; or for a message in the junk folder, the group the message was originally intended for 
before being identified as junk 

 Received Date – the date the message was received by you 
 Replied – an icon indicating if the message has been replied to 
 Score – the score allocated to the message by Messenger Pro’s filtering rules 
 Sent Date – the date the message was sent 
 Size – the size of the message in bytes, kb (kilobytes) or Mb (megabytes) 
 Subject – the subject of the message 
 Thread Counts – unread/total message counts for child messages in a thread 
 To – the name of the person the message was sent to 
 Unread – an icon indicating if the message is unread 

 
The Send tab controls how messages sent to a particular group are handled.  The Sign messages 
when posting to this group option will enable signing of any messages you send to the group, 
while Allow archiving when posting to this group will allow archives to keep a copy of any 
postings you make to the group and make them publicly available. 
 
The Use this identity option sets the default identity used when a message is sent, either in reply to 
a message in the group or when a new message is sent with the group selected.  Click Change to 
bring up a menu of alternative identities if you want to change the current setting. 
  

 
 

If you have multiple signatures set up for a particular identity, you may want to choose one 
depending on which group you’re sending to; for example, if posting to newsgroups discussing 
different topics, you may want a different signature for each one.  Messenger Pro gives you four 
signature options for each group: Use my default signature when posting to this group will use 
the default signature for the selected identity, or for the default identity if none is selected; Don’t 
use a signature when posting to this group will disable the use of a signature completely when 
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posting to the group; Use a random signature when posting to this group will enable Messenger 
Pro to choose a signature at random from all the signatures set up for the selected identity; Use the 
following signature when posting to this group allows you to select a specific signature from the 
combo box underneath.  You can also configure the use of taglines on a per-group basis, using the 
Append a tagline when posting to this group option. 

 
The Tidy tab allows you to control how the group is tidied and also to see current disk usage 
statistics.  Messenger Pro will automatically tidy each group every day and remove messages older 
than a certain number of days but only if the Allow this group to be tidied option is set.  The 
default number of days depends on the type of group (folders aren’t usually tidied at all, 
newsgroups and mailing lists typically expire after 14 days) but this can be changed using the Tidy 
messages older than option.  If you want to ensure that only messages you’ve seen are deleted, 
then you can enable the Only tidy read messages option.  You can further control the tidy process 
by using tidy filters (described in the Filtering Messages section) which are enabled for a particular 
group by setting the Apply tidy filters to this group option. 
 

 
 
Normally, tidied messages are simply deleted (the Delete tidied messages option is set).  However, 
you may instead want to Move tidied messages to another group, in which case you can set this 
option and select a group by clicking Change and selecting the group you want to tidy to. 
 
This tab also allows you to view Disk Usage statistics for the group.  The Total size of messages is 
the total size of all the messages in the group, before compression.  The Amount of space taken by 
messages is the amount of actual disk space used by the messages which takes compression into 
account; the Effective compression ratio expresses the compressed size as a percentage of the total 
size.  Total amount of disk space used then includes the sizes of any indexes Messenger Pro has 
created in order to help it efficiently access the messages and represents the total disk usage of the 
group. 
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When Messenger Pro deletes messages, it only removes the index entry, rather than reclaiming the 
space it takes up.  After a tidy, a compact will be performed to reclaim this wasted space, but the 
current Amount of wastage and the Proportion of wastage are also shown as part of the usage 
statistics.  Pressing Compact will perform an immediate compaction of the group rather than 
waiting for the next tidy; similarly, Tidy now can be used to perform an immediate tidy on that 
group only. 
 
If you experience any problems with a particular group and suspect corruption of the messages or 
Messenger Pro’s indexes, then you can use the Repair button to force it to scan the group for 
messages and rebuild its indexes.  Normally it’ll detect any abnormalities and perform a repair 
automatically, but this facility exists to repair groups manually. 
 
If repairing the group doesn’t help then you may need to access the group’s files directly, usually to 
send a copy of them to support to assist in diagnosing the problem.  The path displayed at the top of 
the Disk Usage section indicates where these files are stored; Windows users may also click the 
Open button to open an Explorer window on this directory. 
 
The Other tab contains a number of additional group options, the first section controlling the way 
groups are listed in the group hierarchy viewer.  By default Messenger Pro will only display unread 
groups, but you can force a group to be always listed by enabling the List group even if all 
messages are read option, which can be overridden using the Don’t list group if it contains no 
messages option.  
 

 
 
When listing a group in the hierarchy, Messenger Pro indicates how many messages are in each 
group and how many are unread.  If the group has any children, you may want these counts to 
include the messages of its children, so the Total child groups in message counts option allows 
this.  The waste basket is an example of where this is used, because in that case it can be useful to 
see the total number of messages in the waste basket rather than just the number of messages in the 
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waste basket group itself (since other messages may be in subfolders of the waste basket which 
wouldn’t otherwise be counted). 
 
Where a folder’s properties are being edited, you may prefer to treat it as a mailbox for display 
purposes, if for instance a folder contains mail sent to a particular address.  The Display folder as a 
mailbox option thus allows the folder to be shown with a mailbox icon but apart from this, no other 
aspect of the folder’s behaviour is affected. 
 
This tab also contains a number of options controlling how messages belonging to the group are 
downloaded.  The option Only download headers from this group by default is applicable to 
IMAP folders and newsgroups and will, if enabled, only download the headers of messages, with 
their bodies left to be fetched later on demand when they’re viewed. 
 
The remaining options are applicable only to newsgroups; the Stop fetching messages for this 
group option will stop any further messages from being downloaded to the current newsgroup, 
although any messages already downloaded will remain.  Reset the number of articles to fetch for 
this group allows you to change the number of old messages that are retrieved from the server on 
the next fetch, with the On next fetch, download option specifying this number. 
 

Group Viewers 
 
Once opened from the group hierarchy viewer, the group viewer displays a listing of messages 
belonging to a single group and allows messages to be opened or various operations to be 
performed on them. 
 

 
 
The list of messages appears in the main part of the window.  Each message is displayed with an 
icon indicating its status (read, replied, flagged, etc.) and a number of items of header information 
(from, subject, received date, etc.) as determined by the columns being displayed for the current 
group. 
 
Above the message listing is given information about the group including its name and how many 
messages are being displayed, with a separate count of unread messages.  Also indicated is whether 
all or just unread messages are currently being displayed.  Right-clicking over this part of the 
window will bring up a menu allowing you to Select Columns to be displayed (which opens the 
Columns tab in the group’s properties editor described earlier), and to Save Column Settings 
which allows you to make a selection of groups for which Messenger Pro will remember the current 
column settings for the next time you open each one.  You can also Reset Column Settings to reset 
these settings to their defaults.  Clicking on the column headings will allow the messages to be 
sorted on the selected column (clicking again to toggle between an ascending and descending sort) 
while dragging the columns will allow them to be reordered.  Note that changes to the ordering of 
columns aren’t saved unless they’re made from the group properties editor.  When you specify each 
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new column to sort on, the current setting is used as a secondary sort and then as a tertiary sort, 
allowing up to three levels of sorting to be configured. 
 
A group will generally open showing only unread messages if it is a newsgroup or mailing list, or 
all messages for a folder, but this can be changed if required by selecting Show Unread/All 
Messages from the View menu.  Newsgroups and mailing lists will also typically be displayed in 
threads which group together discussions so that their structure with respect to which messages 
replies belong to is apparent.  Threads only occupy a single line in the display unless the + button 
next to them is clicked, expanding the thread and also changing the button to a – which will contract 
it if clicked again. 
 
Threading is a form of grouping, which allows related messages to be grouped together in the 
display.  All such grouping options can be found on the Message Grouping submenu of the View 
menu, and include options to Group By Date, Group By Sender, Group By Recipient, Group By 
Newsgroup, Group By Account and Group By Group.  Each of these options will create a 
number of headings in the display and then display messages under the headings to which they 
belong.  For all groupings, including threading, the Expand/Contract Groupings option will fully 
expand each item in the display so that all messages can be seen, or fully contract each one if they 
are already expanded. 
 
If the group viewer is displayed as part of the main window containing the group hierarchy and a 
message viewer, then clicking on a message will display it in the message viewer.  Double-clicking 
can also be used to open a message in its own window.  Messages can be dragged from one group 
viewer to another, or to a group in the group hierarchy, which allows messages to be moved or 
copied between groups. 
 

Message Status 
 
Each message within Messenger Pro has a status which is made up the following attributes which 
are controlled from options on the Message menu, or on its Set Message Status submenu: 
 

 Read or unread 
 Flagged or unflagged 
 Replied or unreplied 
 Locked or unlocked 

 
In addition, a selection of messages can be toggled between read and unread using the Toggle 
Read/Unread button which will toggle the first message in the selection and then set all remaining 
messages in the selection to match the first. 
 
A read message is one that you’ve seen and Messenger Pro will automatically mark messages as 
read as you open them.  You can, however, mark a message as unread, should you wish to be 
reminded to revisit it.  An alternative way of marking a message for attention is to flag it, which 
only occurs when you explicitly tell Messenger Pro to do it (unless the message has high 
importance and Messenger Pro has been configured to flag such messages).  Flagged messages will 
always be displayed when you open a group containing them, regardless of whether you’re 
displaying unread or all messages.   
 
When you send a reply to a message, Messenger Pro will mark the message as replied so that you 
can see at a glance which messages have been replied to and which haven’t, but you can later mark 
the message as unreplied if you wish.  Finally, locking a message will protect it from deletion, 
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either manually or automatically during a tidy, until it is unlocked again; locking can also optionally 
prevent a message from being marked as read if the Lock as Unread option is used. 
 

Deleting Messages 
 
For most groups, deleting a message is a simple matter of selecting it and choosing the Delete 
Message option from the Edit menu.  The message will then be immediately transferred to the 
waste basket (if enabled).  However, in the case of IMAP folders, the message will simply be 
marked for deletion, requiring an expunge of deleted messages to be issued before the deletion will 
actually take place.  This is achieved by selecting Expunge Deleted Messages from the Edit menu.  
Messages marked for deletion can also be unmarked by undeleting them, using the Undelete 
Message option from the Edit menu.  This option can also be used to retrieve messages from the 
waste basket, moving the message to its original location. 
 

Send Operations 
 
The group viewer allows various send operations to be performed on a message, most of which 
make use of the send window described in a later section.  Here we just distinguish between the 
various types of send operations. 
 
A reply to a message is sent via e-mail only to the original author of that message by selecting 
Reply by Mail from the Message menu; a Reply to All will also send the message to any other 
recipients of the original message.  By contrast the Followup to Newsgroup option will send a 
copy to the newsgroup itself (or mailing list) allowing any reader of the newsgroup to see it.  It is 
thus important that the correct option is selected, to ensure that private responses are kept private 
and to reduce noise in newsgroups.  Selecting the Followup and CC to Sender option from the 
Other Send Operations submenu will send both a newsgroup posting and a copy by e-mail, which 
is useful when you want to make a public response but want to ensure that the original poster sees 
it.  Note that some people dislike receiving e-mailed copies and would prefer to read all responses 
in the newsgroup, so use of this option may not be wise in some cases.  Where a particular person 
has expressed a preference, Messenger Pro will attempt to override your selection so that their 
preference is respected, however there is nothing stopping you from then overriding this yourself. 
 
A message can be forwarded to another person in one of two ways.  Forward by Mail will create a 
new message quoting the text from the original message and including brief header information, 
such as its subject, date, sender and who it was sent to.  Forward as Attachment will forward a 
complete copy of the original message by creating a new message attaching the original.  In either 
case you may edit the message that’s created before sending to add your own comments, but only in 
the former case may you edit the forwarded message itself.  A subtle variation on forwarding is 
bouncing, as made available via the Bounce Message option on the Other Send Operations 
submenu.  In this case you are resending the original message with its content and all headers intact 
so that it appears to the recipient in exactly the same way as it does to you, but you may send it to 
an alternative address overriding what appears in the header.  This option should only be used in 
very specialist circumstances. 
 
Also on the Other Send Operations submenu are options to resend messages you’ve written, 
perhaps from your Sent mail, Sent news or Drafts folders.  The Resend by Mail and Resend by 
News options will reopen the selected message in a send window, remembering all settings 
specified for the message including the message text and any attachments.  This allows easy 
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resending of the message in case some mistake was made the first time, for example, if an incorrect 
e-mail address was specified and the original couldn’t be delivered. 
 
This submenu also gives you options to Send Cancel Message and Supersede Message which 
only apply to news messages.  Both result in the original message being cancelled (deleted) on all 
news servers that process the message (note that not all servers will respect this and you may only 
cancel or supersede your own postings) but superseding the message will allow you to post a new 
message that should appear in its place.  A send window will therefore be opened allowing you to 
send this new message when superseding. 
 
The last item on this submenu is Respond using Template which allows you to send a standard 
response to a message based on a template that you’ve designed which incorporates fields from the 
message you’re replying to as well as fixed text.  Templates are edited using the send window and 
are discussed further in that section of the manual. 
 

Decoding Messages 
 
Usually, attachments are contained wholly within a single message and Messenger Pro handles the 
decoding of them automatically whenever you try to access them.  However, in some cases, 
attachments may be split across multiple messages, each containing a fragment of the final file, so 
these need to be reassembled and decoded before the attachment can be saved out.  You can usually 
identify which messages these are and in which order they need to be reassembled, since they’ll 
include a part indicator in the subject, e.g. [1/3].  To decode these messages, you will need to sort 
the display so that they appear in order, and select all the parts of the message.  You will then need 
to either select the UUDecode Messages or YDecode Messages option from the Message menu, 
depending on how the messages are encoded.  Messenger Pro will then join the messages together 
and decode them, prompting you to save any attachments it finds using a standard file selector. 
 

New Arrivals 
 
An alternate form of the group viewer is used when new messages arrive, allowing you to see the 
subject and sender of any new e-mail messages.  Messages can be opened by double-clicking them 
and all the supported message operations can be selected from a pop-up menu obtained by right-
clicking over the messages. 
 

 
 
 
 
 
 



Messenger Pro User Manual 
 

 
21 

Message Viewers 
 
Opening a message from a group viewer will display it in a message viewer which displays the 
contents of a single message and allows all the operations available from the group viewer to be 
applied to that message, plus some additional ones. 
 

 
 

Window Layout 
 
The main part of the window shows the actual message, above which is the header pane which 
shows summarised information from the message header, including the sender (From), the Subject 
and Date (the date the message was composed/sent).  Additionally, the To, Cc, Reply-To, 
Newsgroups and Followup-To headers will be shown if they’re present and it’s deemed useful to 
display that information; for example, there’d be no point displaying the To header if the message is 
addressed only to you, but it would be useful if you have more than one identity since it wouldn’t 
otherwise be obvious which one it was sent to.  Below the message content is the attachments pane 
which appears if the message contains attachments and displays an icon for each attachment 
included in the message.  Note that an attachment icon is always displayed for a rich text (HTML) 
message even though it strictly isn’t an attachment; this is to allow the message to be easily 
launched in a web browser if it uses HTML features that Messenger Pro doesn’t support (for 
example, messages sent by Microsoft software and intended to be rendered by Internet Explorer). 
 
The header pane also contains two buttons, the first allowing navigation through the current thread.  
Clicking this brings up a menu with three submenus: Ancestors, Siblings and Replies.  Ancestors 
are messages that precede the current one, the first of which will be the message’s parent, i.e. the 
one that the current message is a reply to.  The Open Parent option allows more convenient access 
to this ancestor.  Other messages on the ancestors menu are the parent of the current message’s 
parent, and so on up the reply tree.  Replies are direct replies to the current messages whereas 
Siblings are other messages that are replies to the message that the current message is a reply to (i.e. 
messages that share the same parent).  Selecting a message will display it, if available, or prompt 
you to attempt to download it on the next news fetch.  The second button allows selection of the 
currently displayed part or attachment of the message but only appears if there is more than one part 
to choose from.  Where the part is capable of being displayed by Messenger Pro then it’ll be 
displayed; otherwise a save dialogue will appear allowing you to save it to a file. 
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To the left of these buttons is a traffic light icon which indicates the status of the message with 
regard to PGP signature checking (which requires GnuPG to be installed to work).  If no light is on 
then the message isn’t signed; if amber (middle) then it is signed but hasn’t been verified, whereas 
red (top) means a failed verification and green (bottom) a successful one.  If a verification hasn’t 
been performed automatically, it can be done manually by selecting Verify Signature from the 
Message menu.  To the left of the From and Subject fields are buttons allowing filtering rules to be 
created marking all future messages from that sender or with that subject as read (the cross button) 
or to add the current sender to the address book (the plus button). 
 

Navigation 
 
To save you from having to open each message in turn, you can use the previous and next message 
buttons to move through the group as their names suggest.  These options are also on the Go menu 
as Previous Message and Next Message (there is also a second next message option to go to the 
Next Unread Message).  You can also move through entire threads of messages by using the 
previous and next thread buttons, corresponding to the Previous Thread and Next Thread options 
on the same menu; if you don’t want to read the remainder of the current thread, the Skip Current 
Thread option can be used to mark them as read. 
 
The space bar can also be used to scroll the current message down and move on to the next unread 
message in the group when all of the message has been displayed.  When there are no more unread 
messages left, Messenger Pro will move on to the next group containing unread messages. 
 

Attachments 
 
Attachments may be launched, by double-clicking them, or dragged out to another application.  
Alternatively, right-clicking over them will bring up a menu allowing you to Open, Save, Forward 
or Remove the attachment from the message permanently.  Note that because e-mail viruses 
typically spread as attachments, you are advised to check that any attachment you open has been 
sent from a trustworthy source and doesn’t look suspicious.  Messenger Pro will give you a warning 
reminding you of this each time you open an attachment. 
 

Images 
 
The message may contain images which Messenger Pro can display, however the display of images 
may not be enabled by default in which case you’ll see a grey rectangle appear where the image 
should be.  To display these images, select Show Images from the View menu.  You can configure 
whether or not images are displayed automatically by accessing the Display choices in Messenger 
Pro’s main options window.  The description of this option in that section of the manual describes 
why you might want to leave image fetching switched off. 

 

Finding and Replacing Text 
 
The Find Text option allows you to find a piece of text in the current message.   
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Enter the text you want to find in the Text To Find field and click OK; Messenger Pro will then 
highlight the first occurrence it finds.  To find any further occurrences, choose the Find Next option 
from the Edit menu, or press F3. 
 
Messenger Pro can also replace the text it finds with an alternative piece of text using the Replace 
Text option available on the Edit menu. 
 

 
 
Enter the text to find in the Text To Find field and its replacement in the Replace With field and 
click OK; Messenger Pro will then find each occurrence and replace it, optionally prompting you 
before it does so. 
 
The following options are available in these dialogues: 
 

 Case Sensitive – whether or not the found text must match the case of the text you’ve 
entered 

 Whole Words Only – whether or not the text you’ve entered should match whole words or 
partial words 

 From Cursor – whether the search should start from the cursor or from the beginning of the 
message 

 Find Backwards – whether the search should work backwards up to the top of the message 
or forwards to the bottom 

 Prompt On Replace – whether or not you should be prompted before each replacement 
 

Opening, Saving and Printing Messages 
 
As well as allowing you to view messages downloaded or composed within Messenger Pro, you 
can also load messages from disk in the form of raw message files (with a .txt extension) or 
mail/news message files (.eml/.nws) used by other mail and news applications (particularly under 
Windows).  To do this, select Open from the File menu and choose the desired file using the file 
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selector.  Messages can also be saved to a file in either of these formats by selecting Export 
Messages from the File menu. 
 
Messages can be printed by selecting Print from the File menu.  Subject to the message fitting on a 
page, the printed output will be identical to the screen display, although Messenger Pro will include 
a short message header summary on the first page, including From, To, Cc, Newsgroups, Subject 
and Date fields.  Unless you’re printing to a colour printer, coloured messages typically won’t come 
out very well, so colouring is disabled by default, however this can be enabled in Messenger Pro’s 
main options window. 

Viewing Encrypted Messages 
 
Messages encrypted using PGP or GnuPG will be automatically decrypted by Messenger Pro (if 
GnuPG is available) before the message is displayed.  If the message can’t be decrypted, you will 
be shown the encrypted version which you may save out and attempt to decrypt with something 
else. 
 
Where text in the message has been encrypted using the Rot13 algorithm (which maps A to N, N to 
A, B to O, etc.), the message may be decrypted by selecting Apply Rot13 from the Message menu. 
 

Handling Header-Only Messages 
 
When you open a message that belongs to a group or account that has been configured to only 
download message headers, Messenger Pro will automatically reconnect to the account and retrieve 
the message body, displaying it when it has arrived.  This applies both to mail and news accounts. 
For certain newsgroups, however, you may want to make your message selection off-line and batch 
up requests to download full message bodies, for example, when reading binary newsgroups which 
contain large messages which you don’t want to download all of, but instead want to download just 
the ones you want.  In this case, you can use the Fetch Body option on the Message menu to 
submit a request to download the body for the current message on the next news transfer. 
 

Sending Messages 
 
Whether sending mail or news, writing a reply or composing a new message, the same send window 
is used.  The differences are that different fields need to be filled in for mail and news, and in the 
case of a reply, followup or forward, some of these fields will be filled in for you.  Otherwise the 
process of sending messages is the same. 
 

Message Header 
 
The send window is divided into two sections.  The upper half, immediately below the button bars, 
contains fields that will form the message header, and include such details as who the message is 
being sent to or what newsgroups, and the subject of the message. 
 
The fields available are: 
 

 From – the identity you want to send this message from, or an alternative name and e-mail 
address, which will appear to the recipient as the message sender 
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 To – the e-mail addresses, separated by commas, you want to send the message to (mail 
only) 

 Cc (carbon copy)/Mail copy to – additional e-mail addresses, separated by commas, that 
you want to send the message to (for news, this results in a news posting and an e-mail 
message being sent) 

 Subject – the subject of the message, briefly summarising its content and purpose 
 Newsgroups – a comma-separated list of newsgroups to post the message to (news only) 

 

 
 
Extra fields can be displayed by selecting Advanced Options from the View menu.  These 
advanced fields are: 
 

 Bcc (blind carbon copy) – additional e-mail addresses to send the message to which aren’t 
visible to other recipients (mail only) 

 File in – a folder in which to file a copy of the sent message 
 Reply to – an alternative identity or e-mail address to which you’d like replies to your 

message to be sent 
 Followup to – a comma-separated list of newsgroups to which you’d like follow-ups to 

your message to be posted (news only) 
 
The header section of the window can alternatively be replaced by the full message header by 
selecting Edit Headers from the View menu.  This is only recommended for advanced users since a 
mistake could result in non-delivery of the message, but it allows greater flexibility because any 
header not otherwise supported by Messenger Pro can be added.  Note that Messenger Pro will still 
generate certain headers when sending so the header you see before sending will not necessarily 
reflect the exact header that is sent.  If you are concerned about this, you are recommended to 
configure Messenger Pro offline and check the header in the Outbox before allowing it to be sent 
by your mail or news account. 
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If you change your mind about sending an e-mail or making a newsgroup posting, you can select 
the Toggle Mail/News option from the Message menu to change the type of message you’re 
writing, preserving all details entered so far. 
 
For a reply, the To and Subject headers will be automatically filled in, including the Cc header for a 
reply to all.  A forward will also set up the To and Subject headers and a news followup will 
automatically fill in the Newsgroups and Subject headers.  The message body will also be filled in 
with text quoted from the original message, which you need to cut down to the minimum required 
to provide context for your response and then add your own comments. 
 
For address fields, you can select contacts from your address book by clicking Change next to the 
field which will open the contact selector for that field. 
 

 
 
Your contacts are shown on the left and the current recipients are shown on the right; mailing lists 
are also listed on the left to facilitate easy posting to them.  Selecting a contact and clicking Add 
will add it to the field, whereas selecting a recipient and clicking Remove will remove it.  Click OK 
when you are finished.  Address fields also support alias expansion so that if a particular contact has 
an alias defined in your address book, you need only type the alias and Messenger Pro will expand 
the alias and replace it with the name and address of the contact. 
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Editing Your Message 
 
Below the header appears the actual text of your message in which you can type anything you like.  
Your message can be in either plain text or rich text (HTML) format, controlled by the Rich Text 
(HTML) option on the Format menu.  If rich text is enabled, the formatting toolbar will appear 
which allows you to write your message using various fonts, font sizes, bold, italic, underline and 
left, right, centre and full justification options, which also appear on the Format menu.  Please note 
however that your recipient will not see your message in exactly the same way as it appears when 
you compose it, although it will be a close approximation. 
 
Formatting facilities aren’t available when sending in plain text.    If you’re writing your message in 
plain text, you need to pay attention to how your lines are wrapped so that they can be easily read 
by your recipient.  Wrapping means ensuring that lines automatically flow onto the next line after 
so many characters so that lines aren’t too long or aren’t forced to wrap by your recipient’s software 
at awkward places, leading to lines with alternating lengths.  Messenger Pro can be configured to 
automatically wrap text when you send to a certain number of characters, controlled by settings in 
the main options window.  You can also enable word wrapping during editing so that you can see 
where the wrapping will take place, by selecting the Word Wrap option on the Format menu, or 
wrap manually on a paragraph by paragraph basis by selecting Rewrap Paragraph from the same 
menu. 
 
If you wish to insert text from a file you’ve already prepared, you can use the Text from File option 
on the Insert menu to select a file using the standard file selector and paste its contents at the 
current cursor position.  Other editing operations available to you are Swap Case, which will swap 
the case (lower to upper case or vice versa) of the character after the cursor; Transpose, which will 
swap the two characters either side of the cursor; and Snip Text which will delete the current 
selection and replace it with [snip], which is often used to denote text removed from a quote from a 
previous message.  These options appear on the Utilities submenu of the Edit menu. 
 
Messenger Pro will automatically append your signature to your message before displaying the 
send window.  If you wish to change this, you can either change your identity as displayed by the 
From field in the header section of the window, which will replace the signature by the new 
identity’s default signature, or you can choose a signature belonging to the existing identity by 
following the Choose Signature submenu on the Message menu. 
 
At any time during the edit of your message, you can choose to save it and reopen it at a later time.  
Messenger Pro gives you three ways of saving your message: Save as Draft saves a copy of the 
message in your Drafts folder whereas Save to Folder lets you choose an alternative folder using a 
standard group selector; Save to File lets you save the message to a file on disk.  These options can 
be found on the File menu.  
 

Spell Checking 
 
When you’ve finished entering your message, you may want to perform a spell check to ensure that 
there are no spelling mistakes before you send it, which can be started by selecting Spelling | 
Check Message from the Message menu (or alternatively, Check From Cursor to check from the 
current cursor position).  Messenger Pro will then check each word against words in its dictionary 
and ask you about words that appear to be spelt incorrectly. 
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The word in question is displayed at the top and can be manually edited if required.  Alternatively, a 
list of suggestions appears beneath it from which the correct spelling can be selected.  Clicking 
Replace will replace the misspelt word with the replacement that has been entered or selected; 
Replace All will do so for all other occurrences of the same word in the message. 
 
If the word is spelt correctly but doesn’t appear in Messenger Pro’s dictionary, it can be added by 
clicking the Add button; future occurrences of the word will then be handled correctly.  
Alternatively, clicking Ignore will assume any other occurrences of the word are spelt correctly, but 
only during the current spell check, i.e. words aren’t added to the dictionary in this case. 
 

Attachments 
 
If you want to send attachments with your message, they can be specified by selecting Attachment 
from the Insert menu and selecting the file using the standard file selector.  Attachments will 
appear in a pane at the bottom of the window.  If you add an attachment and later change your 
mind, you can remove it by right-clicking over it and selecting Remove Attachment. 
 
The Format menu contains three options controlling how attachments are encoded in your 
message.  You need to select one of these depending on the capabilities of your recipients’ software, 
but the defaults should suffice in most cases: 
 

 Use MIME Encoding – the default for mail.  Only old software will have problems with 
this format. 

 Use UUEncoding – the default for news.  Most software should handle this format but 
newer software may use MIME instead of it. 

 Use YEnc Encoding – only suitable for news.  Only fairly recent software will support this 
encoding. 

 

Message Options 
 
The following options are available on the Message menu and allow you to set various message 
options: 
 

 High Importance – indicate to the recipient that this message is urgent 
 Low Importance – indicate that this message is not important 
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 Request Receipt – request that the recipient send you a receipt to confirm when it has been 
received and/or read 

 Allow Archiving – allow public archives to retain a copy of your message so that other 
people can search for it 

 Encrypt – encrypt the message using GnuPG (if available and all the recipients’ public keys 
are in your keyring) 

 Sign – sign the message using GnuPG (if available and you have created a key for the e-
mail address used by the selected identity) 

 
You can also specify the character set your message is written in using the Character Set submenu 
on the Format menu.  In most cases, Messenger Pro will determine this from your operating 
system and this will be usually correct, however if you’re written your message using language 
specific characters and have reason to believe that the selected character set is wrong, then you can 
specify this manually.  The current character set is displayed in the status bar. 
 

The Address Book 
 
Messenger Pro’s address book allows you to keep all information about your contacts in a single 
place.  For each contact it can record their e-mail address, postal address and telephone number, 
both for home and at work.  It also allows you to record your own notes on each person, as well as 
to assign different sounds to different people, so that you can distinguish new mail arriving from 
each one.  Once entered into the address book, you may select e-mail addresses from a list when 
sending mail so that you don’t need to enter the addresses manually. 
 

The Address Book Window 
 
The address book window is opened by selecting Address Book from the Tools menu. 
 

 
 

It lists all the contacts in your address book, either in name or in address order, under two headings: 
Your contacts, which are the contacts you’ve created yourself, and Automatically created 
contacts, which are those that Messenger Pro has automatically added for you (e.g. when sending a 
reply).  Single address contacts are shown using an icon depicting a single person; group contacts 
and distribution lists depict two people.  Where an alias is defined for a particular contact, this is 
shown in parentheses after the contact’s name. 
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Double-clicking a contact will being up the contact properties editor allowing you to edit it, as will 
selecting it and clicking Properties.  New contacts are created using Add Contact which brings up 
a blank contact properties editor into which details can be entered, while contacts are deleted by 
selecting them and clicking Remove.  Copies of existing contacts can be made by clicking Copy 
and then selecting Copy Details or Share Details from the pop-up menu; the former creates a new 
contact with the same details as the one you are copying which can be changed independently, 
while the latter creates a second view of the first so that any changes to any of the copies are 
reflected in all copies.  The Send button can be used to send an e-mail to the currently selected 
contacts.  New folders can be created using Create Folder into which contacts and folders can be 
moved using drag and drop.  Clicking on the + button next to the folder name will expand the folder 
(and again on the – to contract); alternatively the Expand/Contract option can be chosen from the 
pop-up menu to expand/contract all folders. 
 

The Contact Properties Editor 
 
The contact properties editor has four tabs allowing you to enter different types of information 
about a contact.  The main tab is Details which allows you to specify the contact’s Name (broken 
down into Title, Forenames and Surname), E-mail address and Organization.  You can also 
optionally assign an Alias to the contact which is a short abbreviation which Messenger Pro will 
automatically expand to the full address in the send window. 
 
Instead of a single address, you may specify more than one address, separated by commas, to create 
a group contact which sends mail to multiple addresses.  When setting this up you can use addresses 
or other aliases; Messenger Pro will continue expanding aliases until nothing more can be 
expanded.  An alternative to group contacts is to set the contact up as a distribution list.  Instead of a 
list of addresses you specify a file name which contains the desired list of addresses, which can be 
managed outside of Messenger Pro.  Selecting This contact is a distribution list, and clicking 
Change to specify a file name using the standard file selector, will set this up. 
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The next section contains a number of options that apply when you send mail to this contact.  To 
use any of these, you first need to enable Override default options, otherwise the defaults set in 
the main options window will apply.  Sign correspondence with this contact will enable signing, 
Encrypt correspondence with this contact will enable encryption, Request receipts from this 
contact will enable read receipts and Preferred character set will select the character set to use for 
this contact; to change this either type the character set name or click Change and select it from the 
menu. 
 
Finally, to specify a sound that plays when mail from this contact is received, click Change next to 
the New arrivals sound field to select a suitable sample.  Clicking Clear will remove the current 
selection, while Play will allow you to hear it. 
 
The Personal and Work tabs allow you to enter home and work postal addresses and telephone 
numbers for the contact.  The Send button on each will open a send window allowing you to send 
mail to the specified E-mail address, whereas Open will allow you to view the contact’s Web site.  
The Personal tab also allows you to specify a date of birth for the contact. 
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Finally, the Notes tab allows you to enter anything you like to add to the information recorded for 
the contact. 
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Managing Identities 
 
Messenger Pro allows you to set up multiple identities which a separate e-mail address for each 
one; for example, you may have one identity for your personal mail and another for your work mail 
and Messenger Pro will manage any replies you send making sure they’re sent using the right 
address.  You created an identity when you first set up Messenger Pro, but the identity manager can 
be used to set up additional identities or edit existing ones. 
 

The Identity Manger 
 
The identity manager is opened by selecting Identities from the Tools menu and will display a list 
of your current identities. 
 

 
 
Clicking Add will start the new identity wizard which you used when you installed Messenger Pro; 
Remove will delete any selected identities, while Properties will open the identity properties editor 
allowing you to edit the selected identity. 
 

The Identity Properties Editor 
 
The identity properties editor contains three tabs allowing you to set up various properties of the 
identity.  The main details are specified on the Details tab which asks for Your name (your real 
name, e.g. Joe Bloggs, or whatever you want to appear in place of it), your E-mail address and 
your Organization.  Note that each identity must have a unique e-mail address.  The e-mail address 
you specify will appear in the From header of any messages you write and this will usually be the 
address that replies will be sent to.  If you’d prefer that replies be sent to a different address then 
you may specify an alternative Address for replies. 
 
When you send mail and news, Messenger Pro will automatically store a copy of the message in 
your Sent mail or Sent news folder respectively, unless configured not to.  Alternatively, you may 
specify that each identity stores these copies in different folders by specifying a Default sent mail 
folder or Default sent news folder.  To do this, simply click Change next to the folder you want to 
change and select a folder from the group picker. 
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If you have more than one identity, Messenger Pro needs to know which one you want to use when 
it can’t determine that for itself.  You must therefore configure one to be your default identity by 
selecting the Make this your default identity option.  Only one identity can have this option 
selected. 
 
Each identity can have a number of signatures associated with it, controlled from the Signatures 
tab.  Your signature is the text that Messenger Pro will automatically append to your messages and 
may contain contact information that only applies to a particular identity, so it makes sense to have 
a separate signature for each identity, assuming that you want one at all.   You may also want the 
flexibility of choosing between a number of signatures when you write your message, so Messenger 
Pro allows you to set up more than one. 
 

 
 
The Edit Signatures section allows you to select a signature, edit it, and save it again.  The 
Signature name combo box allows you to select from all your existing signatures or enter a name 
for a new signature.  The large space beneath it is the signature itself which can be modified as 
required.  Once edited, clicking Save will save the signature using the name given for Signature 
name; Delete will delete the signature identified here if it isn’t needed anymore.  As an alternative 
to entering a signature manually, you may instead import a signature from a text file by clicking 
Import and selecting a file. 
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You also need to tell Messenger Pro which signature to use by default by selecting it from the 
Default signature combo box.  Normally you’ll also want to Use a standard separator between 
your message and signature (this is a line consisting only of two dashes and a space) so that 
people replying to your messages can have their software automatically remove the signature. 
 
The Taglines tab allows you to specify that a random tagline is appended to your messages, below 
the signature.  The Append a tagline to the end of your messages option specifies whether or not 
this will happen, whereas your Current Taglines are shown below, one per line, and can be edited.  
Save can then be pressed to save the taglines after editing. 
 

 
 

The final Advanced tab contains a Host name option which allows you to control message ID 
generation on a per-identity basis.  Normally Messenger Pro will generate message IDs based on 
your e-mail address, however in some circumstances this may be undesirable and you may prefer to 
generate them based on a host name unique to a particular identity.  The host name you enter here 
will thus appear on the right hand side of any message ID Messenger Pro generates while leaving 
this field blank will use the default method of ID generation. 

 

 
 

The other field available on this tab is GnuPG User ID which allows you to explicitly state which 
key in your keyring you want to use for a particular identity by entering its ID or fingerprint; refer 
to the GnuPG documentation for further information about how you may specify a user ID. 
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Managing Accounts 
 
Messenger Pro allows you to retrieve mail and news from a number of sources, each of these 
sources being identified by an account.  You set up incoming and outgoing mail accounts when you 
installed Messenger Pro, but the account manager can be used to add additional accounts or edit 
existing ones; for example, you may want to add a news account or download mail from a second 
source. 
 

The Account Manager 
 
The account manager is opened by selecting Accounts from the Tools menu.  It contains three tabs 
listing your Incoming mail, Outgoing mail and News accounts, indicating the name and type of 
each account.  If a particular account is disabled then it will be drawn with a black line through its 
icon. 
 

 
 
Clicking Add will start the new account wizard which you used when installing Messenger Pro.  
Clicking Remove with an account selected will delete it while clicking Properties will allow you to 
edit it using the account properties editor. 
 

The Account Properties Editor 
 
The account properties editor consists of three tabs allowing you to alter various aspects of an 
account’s configuration.  The Account tab identifies the Name of the account and its type.  The 
name can be anything you like but should contain a description of the account that will enable you 
to identify it easily.  It defaults to the host name of the account’s server and this will usually be 
sufficient in most cases. 
 
The Account Type specifies what type of account you are setting up.  A mail account can be either 
incoming (a source of received mail) or outgoing (where you send mail to) and incoming accounts 
can use either the POP3 or IMAP protocols.  Your ISP or network administrator will be able to tell 
you which account type to use.  IMAP can additionally be configured for offline or online use; if 
you want to keep mail on the server and store it in multiple folders also kept on the server, then 
you’ll want to use an online IMAP account.  This also gives the advantage of providing you with a 
consistent view of your mail depending on where you view it from (e.g. from another location or 
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using different software).  An offline IMAP account just downloads mail from your main inbox and 
ignores any other folders.  Usually if you want to do this you’ll be better off using POP3, but IMAP 
can be used if your mail server doesn’t support POP3 retrieval.  Outgoing mail always uses SMTP 
while there’s only a single news account which handles both incoming and outgoing news.  Unlike 
the other options which involve connection to a server, the Mail, from a batch file option can be 
used to periodically check for the presence of a file containing messages that already exists on your 
machine, which Messenger Pro will import and delete the file.  This option only has advanced 
applications. 
 

 
 
Each account can also have a Default identity which allows a correspondence between accounts 
and identities to be established.  If you’re downloading mail from a separate account then it will 
usually have reached there via a different e-mail address, so you may want to create a separate 
identity to manage it which is tied to that address.  Clicking Change will bring up a menu allowing 
you to change the specified identity. 
 
The Server tab contains the information that Messenger Pro needs to connect to the account.  The 
Host name identifies the name or IP address of the server which hosts the account.  The Port is 
automatically filled in for you based on the account type, but can be overridden if needed (in most 
cases you won’t need to).  If you want to use encryption for this account, to guarantee that your 
login details and messages can’t be intercepted by third parties, then you may also enable the 
Encrypt communication with this server (SSL/TLS) option.  Note that the server you’re 
connecting to must support encryption for this option to work.  If enabled, you may then specify 
whether or not encryption should be negotiated using the Allow encryption to be negotiated 
before enabling (STARTTLS) option.  This is the default and should be selected in most cases; it 
allows Messenger Pro to connect to the server using an unencrypted connection and then request 
that encryption is enabled before beginning the transfer.  The alternative is to encrypt the 
connection from the very beginning, but this requires the server to use a non-standard port number 
so that it can distinguish from non-encrypted connections.  Your ISP or network administrator will 
be able to tell you which method you need to use. 
 
If the account requires you to log in then you will need to enable the I need to log in to this 
account option; Messenger Pro will then allow you to enter login details.  You need to specify your 
User name and Password for the account, entering the password twice to ensure it’s been entered 
correctly; alternatively, you can enable the Don’t save login details between sessions option to 
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force Messenger Pro to prompt you for these details when the first fetch occurs for this account 
after startup.  Some servers support a more secure method of authenticating you such that your 
login details are encrypted; if you want to take advantage of this then select the Encrypt login 
details if the server support it option. 
 
Where the account will import messages from a batch file, you may specify the name of the file 
using the File name option. 
 

 
 

Messenger Pro will connect to each account you’ve set up every so often as controlled by the 
Automatically transfer messages every option which specifies a time interval between transfers 
measured in seconds.  The default is not to automatically transfer at all, requiring manual transfers 
to be performed, but this will change to 5 minutes (300 seconds) when this option is first enabled, 
after which you can change it to any interval you like.  Please note, however, that some ISPs and 
network administrators may consider it an abuse of service to check for messages too often, due to 
the load this can place on the server, so it is not recommended to reduce this setting to lower than 
the 5 minute default unless you have permission and good reason to do so. 
 
The Advanced tab allows more advanced options to be set for the account, the selection of which 
depends on the type of account you are editing (note that the illustration shows all possible options 
but not all of these will actually be displayed).  Downloaded messages will usually be deleted from 
the server to avoid repeatedly downloading them, and to conserve disk space on the server, but this 
can be disabled by setting the option Leave messages on server (where supported) in which case 
Messenger Pro will attempt to remember which messages it has seen.  If it can’t do this, because the 
server doesn’t provide it with enough information, then deletion will still take place. 
 
In order to speed up download times for messages that may not all be read, you can choose to fetch 
only the message headers by enabling the Only fetch message headers; fetch bodies when asked 
option.  Messenger Pro will then download enough information to list the message in its group 
viewer, but won’t actually download the message body until you try to view it, at which point it will 
connect to the server and fetch the body, deleting the message if configured to do so.  If you’re 
editing an outgoing mail account then you can use the Make this your default send account 
option to make the account the default for sending mail.  This allows you to have more than one set 
up without forcing Messenger Pro to guess which one it should use. 
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Accounts can be temporarily disabled by setting the Don’t allow this account to send or receive 
messages option; this will prevent the account from making any connections and downloading or 
sending any messages.  There is an exception in the case of an online IMAP account however, since 
synchronisation with the server can take place when Messenger Pro is explicitly told to perform a 
transfer only for that account, using the account option on the Send and Receive submenu of the 
Tools menu, or using the Synchronise option which is brought up by right-clicking over the 
account name in the group hierarchy viewer.  Note that under these circumstances, header fetches 
are disabled and full message downloads are always performed.  This enables Messenger Pro to 
support what is referred to as IMAP disconnected operation where the account either behaves as a 
fully fledged online IMAP account or in a more restricted disconnected mode where 
synchronisations must be explicitly initiated.  A further Online option is present on the group 
hierarchy menu to control this setting more conveniently for IMAP accounts. 
 
All communication with the server can optionally be logged by enabling the Log all 
communication with the server option.  This can be useful for tracking down any connection 
problems or any incompatibilities between Messenger Pro and the server you’re using.  The 
contents of the log can be viewed by pressing the View Log button.  By default, Messenger Pro 
will make only one connection with the server, but can be configured to make as many as four if the 
server allows it by changing the Limit simultaneous server connections to option.  Only news 
accounts can take advantage of this feature and you should check first with your ISP or network 
administrator that you are permitted to open more than one connection as this could be considered 
abusive. 
 
By default, junk mail filtering is performed for all accounts (but only if it is also enabled in the Junk 
Mail Filtering window), but if you know that the account will never receive any junk mail then you 
can disable the Apply junk filtering to mail from this account option to gain a small performance 
increase and remove the risk of messages being misclassified. 
 
For IMAP and news accounts, Messenger Pro will check for new folders or newsgroups every so 
often depending on the value of the Check for new groups every option.  For IMAP accounts, the 
hierarchy used for folder listings can be changed by setting the Limit IMAP folder listing to 
hierarchy option.  This is useful if a lot of files are listed by the server but only a small number of 
them are actual mail folders. 



Messenger Pro User Manual 
 

 
40 

 
The Transfers also trigger option can be used to enable a transfer on one account to trigger a 
transfer on another.  This is useful, for example, in pairing an incoming mail account with an 
outgoing account, so that both can be synchronised at the same time. 
 
The Default group to store incoming mail option specifies which group will receive messages 
downloaded from this account.  By default this is blank which means that mail will be stored in 
your Inbox, along with all your other mail, but you can change this setting if you need to.  This 
allows you to keep mail from each account separate without the need to specify filtering rules to 
separate them. 
 
The Refetch articles to catch any missing on last fetch option should only be used with news 
servers that aren’t working properly and report that articles aren’t available, only to make them 
available after Messenger Pro has already asked for them and moved on.  Entering a number here 
will make Messenger Pro wind back that number of articles every time it downloads from the 
server, giving a second chance to download any articles that may have appeared since last time.  
Note that this will decrease download performance and also risks downloading duplicate messages 
if it finds messages that Messenger Pro has downloaded before but expired, so this option should be 
used with care and only if absolutely necessary. 
 

Filtering Messages 
 
Messenger Pro contains powerful facilities for filtering messages.  You can set up various rules to 
look for certain things in messages, such as particular words in the body or fields in the header, and 
then to take certain actions if these things are found.  Filters can be used to automatically mark 
uninteresting messages as read or delete them, to bring important messages to your attention or to 
store particular messages in different folders.  Access to Messenger Pro’s filtering facilities is 
achieved by selecting Filters from the Tools menu which will open the filter manager. 
 

The Filter Manager 
 
The filter manager contains seven tabs, each of which lets you see your Mail (incoming), News 
(incoming), Sent Mail, Sent News, Open and Tidy filters; the seventh tab allows you to see All 
defined filters of any type. 
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Each filter listing contains the name of the filter and an English description of what the filter does, 
in case the name isn’t sufficient; a disabled filter is indicated by drawing a line through its icon.  
Mail filters are applied to e-mail as it is downloaded, News filters are similarly applied to 
downloaded news.  Sent Mail filters are applied when you send messages by mail, while Sent 
News filters are applied to sent news messages.  Open filters are applied every time you open a 
group and for this reason should be used rarely since their operation will be slow in comparison to 
other filters which only filter once when a message is sent or received.  Tidy filters are used when 
tidying (expiring) groups and can allow rules to be set up to automatically move or delete messages 
as part of the tidy process. 
 
Filters are applied to messages in a specified order which the filter manager reflects; filters 
displayed at the top are applied before filters which appear lower down.  Since filters can have more 
than one type, the same filter may be listed on multiple tabs of the filter manger, and this can make 
it difficult to control where it is applied compared to other filters.  For this reason, the All tab is best 
used for changing the ordering of filters, since this lists all filters and thus the definitive filter 
ordering.  Selecting a filter and clicking Move Up will move the filter up the list (increasing its 
priority) while Move Down will move it down (decreasing its priority).  To move filters up or down 
by more than one step, you may use the Move Up By… and Move Down By… buttons which will 
prompt for the desired amount. 
 
A filter can be applied to a selection of groups immediately by clicking the Use Now button.  This 
will open the use filter dialogue which prompts for a selection of groups to be made; to do this, 
click Change and select the desired groups from the group selector.  Clicking OK will then use the 
filter on all messages in those groups.  Using a filter in this way is useful when a new filter has been 
created to be applied to newly downloaded messages, but already downloaded messages need to be 
filtered as well.  In this case, using the filter immediately will take care of the old messages whereas 
new messages will be filtered as they’re downloaded. 
 

 
 

New filters are created using Add while existing filters can be edited by double-clicking them or by 
selecting them and clicking Properties.  If you wish to create a new filter based on an existing filte 
definition, the Clone button will do this for you.  Filters can be deleted by selecting them and 
clicking Remove. 
 

Creating Filters 
 
New filters are created by clicking Add from the filter manager.  This will start the new filter 
wizard which will take you through the process of creating a new filter.  Click Next to begin. 
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You must first tell Messenger Pro when the filter is to be applied, i.e. whether it is an incoming 
mail or news, an outgoing mail or news, an open or a tidy filter.  Tick all the options that apply and 
then click Next to continue. 
 

 
 
You will then be asked what criteria messages must satisfy in order to be matched by the filter.  
Multiple criteria can be defined which can be combined using OR (either of the given criteria must 
be satisfied) or AND (all of the given criteria must be satisfied) logic.  All currently defined criteria 
are listed and their order can be changed by selecting a clause and clicking Move Up to move it up 
the list and Move Down to move it down.  Clauses toward the top of the list are tested before 
clauses appearing lower down.  Note that a filter with no clauses specified will match every 
message. 
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Clauses can be removed by selecting them and clicking Remove and edited by clicking Edit or by 
double-clicking the clause you want to change.  Clicking Add will allow you to define a new 
clause. 
 

 
 
 
 
Each clause specifies a Value To Match, a place to Look for Value and the Type of Comparison 
to perform.  The value is a piece of text that you expect to find in a particular part of any messages 
that you want to be filtered.  This may be an e-mail address or a word contained in the subject or 
body of the message or anything you like.  You can look for the text Anywhere in the message 
body, In the subject of the message, In the name and e-mail address of the message sender, 
Anywhere in the message header or In a specific header field.  For most users, the options to 
look in the subject, body and the message sender will be sufficient, but advanced users with an 
understanding of message headers may want to look anywhere in the header or specify a particular 
header field, which may be selected from a drop-down menu or typed manually. 
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You can also perform tests on the message’s account, identity, group or status flags (i.e. read, 
replied, flagged and whether the message contains attachments), in which case the value to match 
field will be replaced by an appropriate edit field.  In either of these cases, the current selection will 
be shown and clicking Change will allow it to be altered. 
 
Where the clause has other clauses preceding it, you will also be asked to specify whether it should 
be combined with earlier clauses using OR or AND logic.  This allows either any of the clauses to 
be matched or all of them. 
 
Finally, clicking OK will set the clause and add it to the filter.  Once all criteria have been entered, 
clicking Next will allow the filter’s actions to be specified.  The following actions are available: 
 

 Place message in waste basket – effectively deleting the message but it’s still available in 
the waste basket 

 Delete message – deleting the message with no way to get it back 
 Copy message to – copying the message to another folder, leaving the original in place 
 Move message to – moving the message to another folder, with no copy kept 
 Increase score by – increase the score assigned to the message by a certain amount 
 Decrease score by – decrease the score by a certain amount 
 Multiple score by – multiply the score by a certain amount 
 Divide score by – divide the score by a certain amount 
 Set score to – set the score to an absolute value, disregarding the previous score 
 Mark message as read 
 Mark message as unread 
 Mark message as replied 
 Mark message as unreplied 
 Flag message 
 Unflag message 
 Colour message – display the message using an alternate colour in the group viewer. 
 Play sound – play a sound when matching messages are found. 
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 Add header – add a custom header to matching messages.  You need to enter both the 
header field, followed by a colon and a space, followed by the header content 
e.g.  X-Header: Test.  This is mainly of use for outgoing mail and news filters. 

 Append to file – append the message to a file in mail batch format.  This is a useful way to 
export messages for use with other software based on filtering criteria.  You will need to 
specify the location of the file which must be writable by you. 

 Extract attachments to – extract all the attachments contained in the message to the named 
directory.  Files will be automatically renamed in the event of name clashes. 

 Add to address book from – add the addresses found in the specified header to the address 
book (if not already present). 

 Reply using template – send an auto-reply to the message using the specified template. 
 Forward to – forward the message (without attachments) to the specified address. 
 Forward as attachment to – forward the entire message as an attachment to the specified 

address. 
 Bounce to – bounce the message to the specified address. 

 
Scoring is a technique for allocating a score (a simple numeric value) to each message based on 
filtering rules.  Each rule can increase or decrease a message’s score depending on whether or not 
the message meets certain criteria.  The score starts at 0 and the final score can be used either to sort 
on in the group viewer, displaying highly scoring messages first, or to take some other action, 
perhaps to delete low scoring messages which aren’t important. 
 

 
 
Actions are added by clicking Add and selecting the desired action from the drop-down menu. 
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Where a group, colour, sound sample, score value, header or file name is required, an additional 
field will appear to prompt you for it.  Clicking OK will then add the action to the filter. 
 
Like clauses, actions are also applied in the order they appear in the listing and can be reordered by 
clicking Move Up or Move Down.  Existing actions can be edited by selecting them and clicking 
Edit, or removed using Remove. 
 
Clicking Next will move on to the last page of the wizard, after which clicking Finish will create 
the filter and display its properties so that you can enter a name for it and confirm that it has been 
set up as you want it. 
 

 
 

Editing Filters 
 
Filters are edited by selecting them from the filter manager and clicking Properties.  This opens the 
filter properties editor.  The first tab, Details, is what interests us most here. 
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The filter Name can be anything you like, as long as it identifies the filter to you when displayed in 
the filter manager.  The options of When To Apply Filter are also here and have the same effect as 
the corresponding options in the new filter wizard.  In addition, if the Opening Groups option is 
selected then the When Opening Groups option can be used to select specific groups that have the 
filter applied to them when they’re opened; the default when no groups are selected here is to apply 
the filter to all groups.  To change the groups, press Change and select the groups from the group 
selector. 
 
By default, filters are kept until you explicitly delete them, but in some circumstances you may 
want them to be deleted automatically after some period of time that you specify, for example, if 
you’re filtering out a certain newsgroup thread which will die down naturally after a week or so.  
The options for Filter Expiry are to Keep filter forever in which case no automatic deletion will 
occur, Remove if not matched for which will allow you to specify an amount of time that the filter 
will be kept after its last use, i.e. as long as the filter is being triggered then it won’t be deleted, but 
if the time period specified passes with no matches, then it will be deleted.  The final option is 
Remove after which specifies a fixed period of time after which the filter is deleted, regardless of 
whether the filter is used or not.  Next to this combo-box is a spin-box allowing you to enter a 
number and another combo-box which specifies whether this number is a number of Days, Weeks 
or Months. 
 
The remaining options are to Allow other filters to process matched messages which specifies 
whether or not other filters can be considered if the current filter matches successfully.  Enabling 
this option will increase performance if you are sure that no other filters will need to operate on the 
message or alternatively it can be used to ensure that the current filter prevents certain messages 
from being processed by destructive filters further down the list, for example, if you have a list of 
filters which identify non-junk mail and end the list with a filter which assumes anything reaching it 
is junk and should be discarded.  You can further control the filtering of junk mail using the Allow 
junk mail filtering to process matched messages option which determines whether or not junk 
filtering is allowed to be performed following a match with the filter.  Depending on what the filter 
looks for, it may be that matching messages can never be junk (because junk messages won’t have 
the characteristics you’ve specified), in which case junk filtering serves no purpose.  Note that if 
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this option is enabled then for it to be effective, junk mail filtering must be enabled both for the 
account downloading the mail and in the Junk Mail Filtering window. 
 
The Log the results whenever this filter is considered option will include information in 
Messenger Pro’s log whenever a message passes through this filter, including the tests that are 
performed and whether or not they are successful.  This can be useful for debugging filters if certain 
messages are filtered but others aren’t, but it will decrease performance and should not be enabled 
permanently.  If you want to temporarily disable a filter, you can set the option This filter is 
disabled and the filter will no longer be considered until re-enabled. 
 
By default Messenger Pro will not apply filters to messages you have locked, but if you wish to 
override this behaviour then you can enable the option Allow this filter to process locked 
messages. 
 
The Criteria and Actions tabs simply show the same lists of clauses and actions as used by the new 
filter wizard and are used in the same way. 
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The Schedule tab allows you to specify when the filter is effective.  By default the filter will be 
used at all times but you can instruct Messenger Pro to Only use this filter on certain dates, Only 
use this filter at certain times and Only use this filter on certain days of the week.  These 
options may be combined or used singly. 
 

 
 

For each option you need to specify either the range of dates between which the filter will be active, 
the range of times, or the specific days of the week respectively.  You can also specify that the filter 
is instead active outside of the specified dates and times using the Use this filter only outside these 
dates and Use this filter only outside these times options. 
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Junk Mail Filtering 

Overview 
 
Messenger Pro contains two kinds of support for filtering of junk mail messages.  The first, basic 
filtering, works by identifying messages that aren’t sent to you explicitly, since a lot of junk mail is 
sent by BCC’ing (blind carbon copying) all recipients to save time by not sending a separate copy 
to each one.  The second is adaptive filtering, which can be used in addition to or instead of basic 
filtering.  Adaptive filtering allows Messenger Pro to gradually learn what constitutes a junk 
message and what constitutes a normal message by inspecting the mail you receive and using 
Bayesian techniques (a branch of probability theory) to analyse them.  The more mail it receives, 
the better Messenger Pro should be able to filter out the junk.  To help prevent misclassifying 
messages from people you know, Messenger Pro can be configured to not use either filter on 
messages sent from those addresses that appear in your address book or in the known sender list 
described below.  Junk filtering is applied after any user-defined filters you’ve set up, which allows 
you to define further exceptions or specify your own junk filtering rules, which can help the 
learning process.  All messages identified as junk will be stored in your Junk folder which by 
default will be deleted after 7 days.  This is to give you a chance to check this folder periodically for 
any messages which may have been wrongly identified as junk. 
 

Correction and Training 
 
During the early stages, Messenger Pro is likely to make mistakes, missing junk messages or 
treating normal messages as junk.  In these cases, Messenger Pro must be told to correct its 
mistakes by using the Correct Junk Misclassification option on the Message menu.  This will 
move the message to where it should have gone and then relearn the message correctly, if adaptive 
filtering is in use.  Other options related to adaptive filtering are available on the Junk Mail 
Filtering submenu, which appears on the Utilities submenu of the Message menu.  The Learn 
Message and Unlearn Message options can be used to perform manual training on existing 
messages if desired.  Manual training isn’t mandatory since Messenger Pro will automatically learn 
from incoming mail with your help (i.e. when you correct it) and it only needs to have seen one 
junk message and one non-junk message before adaptive filtering will begin.  However, pre-training 
is useful to increase the accuracy of this process which should lead to fewer corrections being 
necessary.  Messenger Pro will determine whether to learn the messages as junk or not depending 
on whether or not the messages belong to the Junk folder.  Messenger Pro knows which messages 
have been learnt and which haven’t, so it’s possible to submit a selection of messages for learning 
with automatic detection of those that haven’t been seen before.  A Calculate Junk Probability 
option is also present, which will tell you the probability assigned to a message given the current 
state of Messenger Pro’s knowledge.  Note that usually the message will have already been learnt 
which would give a misleading probability, therefore Messenger Pro will adjust the probability to 
reflect how it would score it if it hadn’t been seen before.  A high probability indicates a high 
likelihood that the message is junk message; these probabilities are also logged to the global log 
during the receipt of mail. 
 

The Junk Mail Filtering Window 
 
To configure junk mail filtering, select Junk Mail Filtering from the Tools menu. 
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The General tab allows you to configure which types of filtering are performed and whether any 
exceptions are made, with the remaining tabs allowing you to configure these in more detail. The 
option Enable basic filtering of junk mail controls whether or not the address based filtering 
described above will be performed, whereas the Enable adaptive (Bayesian) filtering option 
controls whether the auto-learning method of filtering is performed.  These options can be enabled 
independently and configured by pressing the corresponding Properties button. 
 
If you want to make sure that messages sent by people in your address book are never filtered, then 
you can enable the Don’t filter messages sent from people in your address book option.  You 
can also specify additional addresses that don’t appear in your address book but for which you want 
to disable filtering, by enabling the Don’t filter messages sent from additional addresses you 
specify option and clicking Properties to edit the list of addresses to which this applies.  These 
options can be enabled independently. 
 
The final option on this tab is to Mark junk messages as read.  The default is to leave them unread 
so that you can pick out new arrivals in your Junk folder when you check for messages that have 
been misclassified, but you can instead automatically mark them as read if you prefer. 
 
If you are making use of basic filtering then Messenger Pro needs to know about all the e-mail 
addresses that can be used to contact you.  Usually it’ll know all of your addresses because you’ll 
have set up identities corresponding to each one, but in the event that you have other addresses that 
you don’t want to set up as identities, additional addresses can be specified on the Basic tab.  
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Your current list of addresses known to Messenger Pro, excluding identities, is displayed in the 
section of the window labelled Your Addresses.  Here you may click Add to add a new address, 
Edit to change an existing one, or Remove to delete it.  Note that you can use the wildcard * to 
match anything, so the example shown will match anything@intellegit.com and will accept all mail 
sent to an address of that form. 
 

 
 
Adaptive filtering is configured on the Adaptive tab.  Using this type of filtering, each message is 
assigned a probability that it is a junk message and you set a threshold which will result in messages 
being treated as junk if their probabilities exceed it.  The Filter messages with a junk probability 
of more than option controls this threshold. 
 
Normally Messenger Pro only needs to have seen one junk message and one non-junk message 
before enabling adaptive filtering, but if you want to perform more training first, the Filter only 
after learning option can be used to increase the number of messages that are required.  Note that 
the figure refers to the number of messages learnt of each type, not their total. 
 
The final option on this tab controls the size of the filtering database.  When a message is filtered, it 
is broken down into a number of tokens, usually representing the words used in the message, which 
Messenger Pro stores in a database along with the number of times it has seen each one.  A limit is 
placed on the size of this database to avoid using up too much memory and to maintain 
performance, and Messenger Pro will automatically expire rarely used tokens when this limit is 
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exceeded.  The Don’t let the filtering database grow larger than option specifies the maximum 
number of tokens that Messenger Pro will keep. 
 

 
 

The Senders tab allows you to specify additional e-mail addresses that aren’t in your address book 
but which you want excluded from the filtering process when you receive messages from them.  
Again, wildcards are supported, and clicking Add will add an address, Edit will edit an existing one 
and Remove will delete one. 
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At the bottom of this tab is the Automatically add addresses I send mail to option which allows 
Messenger Pro to automatically build up a list of people whose mail you want to accept based on 
the people you send mail to, so when you send a message to a particular address, you know that any 
replies won’t be blocked.  The list of addresses groups these addresses separately from those that 
you’ve added yourself so that you can easily distinguish between them. 
 
The Statistics tab shows a number of statistics relating to the junk filtering process. 
 



Messenger Pro User Manual 
 

 
55 

 
 
The Number of junk messages received and Number of good (non-junk) messages received are 
self explanatory, but refer to these counts after any manual correction has been made.  The number 
of corrections is indicated by the Number of false positives (normal messages misidentified as 
junk) and Number of false negatives (junk messages that were let through).  Also shown are the 
number of Junk messages identified by adaptive (Bayesian) filtering, Junk messages identified 
by basic filtering, and Junk messages identified by user filtering/training.  This latter count 
includes messages diverted to the Junk folder by filters that you’ve set up yourself and those 
messages you’ve used to train Messenger Pro manually.  Note that these three counts show 
uncorrected figures so their total will not be the same as the displayed number of junk messages 
received if you’ve had to make any corrections.  The Number of tokens in filtering database is 
also shown, which corresponds to the length of the list of tokens shown below. 
 
Underneath is a breakdown of all the tokens (words, strings, etc.) found in received messages and a 
count of the number of occurrences of each appearing in good and junk messages respectively; this 
information is not displayed by default because of the time taken to sort and display it so pressing 
Refresh is required to display it.  You should find that certain tokens only appear in junk messages 
and others only in good messages and it is this information that forms the basis for adaptive 
filtering.  This token database is periodically expired so that tokens that haven’t been encountered 
recently are removed, thus maintaining performance and ensuring that changes to the content of 
your incoming mail are reflected in the filtering process. 
 
The contents of this tab are not automatically updated as new messages are added; instead you’ll 
need to press the Refresh button to update them.  You can also purge all Messenger Pro’s filtering 
data, forcing it to forget everything that it has learnt, by clicking the Clear button.  This is not 
recommended unless the accuracy of the filtering has become poor enough to justify starting again 
from scratch. 
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Handling Mailing Lists 
 
Mailing lists can be thought of as newsgroups that are distributed via e-mail.  They often have 
similar properties to newsgroups, i.e. they carry discussions between groups of people rather than 
one-to-one communications, and it is thus useful to treat them as newsgroups so that they can be 
threaded and so that it’s possible to have separate options for replying to the author of a message or 
to the list itself, i.e. what would be referred to as a reply and a followup in a newsgroup context.  
Messenger Pro thus allows mailing lists to be treated as newsgroups by filtering them to a separate 
folder and then listing that folder as a mailing list which supports threading and separate reply and 
followup options, as well as allowing new threads to be easily started by supplying the list address 
when a new posting is made to the list. 
 

The Mailing List Manager 
 
The mailing list manager controls all aspects of mailing lists’ configuration and can be opened by 
selecting Mailing Lists from the Tools menu.  It displays a list of mailing lists by name and their 
posting address.  Double-clicking one of these or selecting one and clicking Properties will allow 
the list to be edited using the mailing list properties editor; lists are deleted by selecting them and 
clicking Remove while new ones are created by clicking Add which start the new mailing list 
wizard. 
 

 
 
Where Messenger Pro has been told how to subscribe and unsubscribe to a particular list, the 
Subscribe and Unsubscribe buttons can be used to trigger an appropriate request for the selected 
list. 
 

Creating a New Mailing List 
 
New lists are created using the new mailing list wizard, obtained by clicking Add from the mailing 
list manager.  The wizard will take you through the steps of creating a new mailing list including 
setting up filtering criteria for messages sent to the list and specifying the list submission address 
(i.e. the address you need to send messages to if you want to post to the list).  The filtering stage is 
optional; if you are already filtering messages to a separate folder, whether in Messenger Pro or on 
an IMAP server where server-side filtering has been set up, then you won’t need Messenger Pro to 
set up a filter as part of the mailing list setup and you’ll instead need to identify the group that 
Messenger Pro will treat as a mailing list from this moment on.  Click Next to begin. 
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The first stage is therefore to tell Messenger Pro whether or not filtering is required.  If you don’t 
already have a group set up for the mailing list then you’ll need to select the option I need to filter 
the list messages into a new group – Messenger Pro will then create a group for you.  If the group 
already exists then you need to tell Messenger Pro whether or not it needs to perform the filtering 
for you, using either of the options I need a filter but I’ve already created a group containing 
the list postings, if a filter is required, or I just want to treat an existing group as a mailing list 
with no filtering, if not.  Once your choice has been made, click Next to continue. 
 

 
 
If you are using an existing group then you are asked to specify it on the next page of the wizard by 
clicking Change and selecting it from a standard group selector.  Then, click Next to continue. 
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Otherwise, you’re then asked to enter a set of filtering criteria that can be used to identify messages 
sent to the list so that Messenger Pro can divert them from your inbox to the mailing list group.  
Setting the criteria up is done in the same way as for a filter; see the Filtering Messages section of 
this manual for more details. 
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Once the criteria have been entered, click Next and you then need only enter the list submission 
address, i.e. the address where list postings are sent to. 
 

 
 
After this stage, the wizard is complete.  Click Finish to create the mailing list with the specified 
details.  A mailing list properties editor will then be displayed for the created list, allowing its 
details to be finalised, for example, the name you want to use for the list. 
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Editing Mailing List Properties 
 
The mailing list properties editor contains two tabs, the second listing the filtering Criteria used for 
the mailing list which is used in exactly the same way as for the filter properties editor.  We shall 
thus focus on the Details tab here. 
 
The list Name is what you want Messenger Pro to refer to the mailing list as.  By default, it’s set to 
what appears to the left of the @ in the list submission address, but this can be changed to anything 
you like.  The E-mail address for the list is also shown here. 
 
If you would like Messenger Pro to handle subscription requests for you then you can enter a 
Subscribe URL and an Unsubscribe URL which tell Messenger Pro how to subscribe you to and 
from the list.  Usually these will be in the form of mailto: URLs identifying an e-mail address which 
accepts subscription requests, but alternatively they may specify web based or other forms of URL. 
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The Group used to store list postings is then shown.  If Messenger Pro created a new group when 
you set up the list then this option won’t apply since Messenger Pro manages the group for you.  
Otherwise, you can change the group that is treated as a mailing list by clicking Change and 
selecting the new group from the group selector.  Also included here is the Group Properties 
button which provides a convenient shortcut to the mailing list’s group properties editor. 
 
Some mailing lists prefix the subject of all postings made to the list with the list name.  Some lists 
require this prefix to be added manually, in which case you need to select the Add a prefix to any 
postings I make to this list option.  You may also want to aid presentation of the list in Messenger 
Pro by enabling the Remove prefix from any postings I receive from this list option, which will 
remove the prefix from the subject when displaying messages from the list.  The Prefix itself is 
entered underneath these options. 



Messenger Pro User Manual 
 

 
62 

The Calendar 
 
Messenger Pro contains a fully featured calendar and task list which can be opened by selecting the 
Calendar option from the Tools menu. 
 

 
 

At the top-left is a date picker which allows you to go quickly to a particular date; simply use the 
arrow buttons to choose the desired month and then click on the desired date.  On the right will 
appear the current month, fortnight, week or day, depending on the currently selected view, as well 
as any events scheduled for those days.  Today’s date is indicated by a red box; to go to today, 
select View | Go To | Today from the menu. 
 
The currently selected view is selected from the View menu using the Day, Week, Two Weeks 
(fortnight) and Month options.  The week, fortnight and month views show each day as a box with 
a listing of all events scheduled for that day; the day view lists time by the side with each event 
lined up against its start and finish times. 
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The fortnight (two week) view: 
 

 
 
The week view: 
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The day view: 
 

 
 

At the bottom-right of the window is your task list which shows a list of all outstanding tasks and 
their due dates. 
 

Adding and Editing Events 
 
To add a new event, select File | New | New Event from the menu, or to edit an existing event, 
select it and choose File | Properties; the event properties editor will then appear. 
 
The Details section of the editor allows you to specify a Title for the event (i.e. a short description 
which is shown in the calendar) and an optional Location and Category.  Messenger Pro will 
remember your most popular locations which can be selected from the drop-down menu, thus 
saving you from having to type them each time.  The category of an event determines the colour 
which is used to display it in the calendar. 
 
After completing these details you may specify the Start and End dates for the event using 
Messenger Pro’s date and time edit controls; if the event is an All day event then select this option 
and you won’t need to specify the exact times at which the event starts and finishes.  If the event is 
to occur more than once then Messenger Pro allows you to specify how often it repeats so that each 
occurrence can be shown in your calendar; select the This event occurs more than once option to 
enable the Recurrence tab which allows you to provide this information. 
 
If you’d like Messenger Pro to remind you when this event starts, or a certain amount of time 
before, you can enable the Remind me about this event option and select (or type) the desired 
period of notice in the associated combo-box.  Finally, you may enter some free-form Notes at the 
bottom of the editor, to provide any further details that you’d like to be associated with this event. 
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The Recurrence tab allows you to specify how often an event will repeat and on what days. 
 

 
 

Event Categories 
 
Each event can be assigned one of a number of categories such as Birthdays, Meeting, Personal and 
Work, or a user-defined category.  Events belonging to the Birthdays category are automatically 
derived from your address book for those contacts for whom you have specified a date of birth.  
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Each category has assigned to it a colour, allowing events from different categories to be 
distinguished in the calendar by their display using these colours. 
 
The Categories button in the event properties editor allows you to see the list of currently defined 
categories and their colours: 
 

 
 
Clicking Add will allow you to add a new category, whilst selecting a category and clicking 
Properties will let you edit one; Remove will delete a category from the list. 
 

 
 
Defining a category is straightforward: simply give it a name and optionally select a colour, then 
click OK. 
 

Adding and Editing Tasks 
 
New tasks are added by selecting File | New | New Task while existing ones are edited by selecting 
them in the task list and choosing File | Properties.  The task properties editor is very similar to the 
event properties editor but has a few differences: 
 

 There are no Location or Category fields 
 Tasks can have a Priority of Low, Medium or High 
 Tasks have a Completed field which indicates how much of the task has been completed, 

expressed as a percentage 
 
Otherwise, the other fields are treated in exactly the same way as they are for events. 
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Reminders 
 
When an event or task is due and you’ve asked Messenger Pro to remind you, the Due Events 
dialogue will appear listing all such events and tasks and when they are due. 
 

 
 
The dialogue can be immediately dismissed by clicking OK, or if you’d like a further reminder, you 
may select the Remind me again in option and select the desired period of notice before clicking 
OK. 
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Configuring Messenger Pro 
 
Most of Messenger Pro’s configuration options may be edited using the main options window, 
brought up by selecting the Options entry on the Tools menu.  In addition to the options found 
here, options affecting individual groups, contacts, accounts, identities, mailing lists and filters can 
be found elsewhere in their respective configuration windows. 
 
Messenger Pro’s options are split into a number of sections, each of which is displayed separately.  
The left hand side of the window lists these sections and the right hand side shows the options 
belonging to the current section.  To view a different section, simply click on its name in the list. 
 

Message Display Options 
 
The Message Display section controls how Messenger Pro displays the contents of messages to 
you in its message viewer.  Messages sent in rich text (HTML) format will generally specify 
themselves how they are to be displayed, but the options here can be used to specify how plain text 
messages are displayed.  The Default font option specifies which font Messenger Pro will use for 
the message text, including font name, size and effects (bold, italic, etc.).  Clicking the Change 
button will open a standard font selector to allow this to be changed. 

 

 
 
When you receive a rich text message, you will generally want to view the message with all 
formatting shown as the sender intended.  However, usually such messages are sent with a plain text 
version which you may prefer to view instead; for example, this may make them easier to read if 
unusual formatting choices have been made.  The Don’t display rich text (HTML) if plain text 
available option allows you to force the display of the plain text version in these cases. 
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Rich text messages can contain images which Messenger Pro is capable of displaying but you may 
prefer not to display these.  For example, if you receive junk mail with adult content then you may 
not wish to be exposed to images that may offend and may prefer to display images only for certain 
messages once you have verified the sender and content.  The Don’t display any images in 
messages option will completely disable the display of images, although you will still be able to 
select an option to display the images should you want to.  Since some messages contain the images 
embedded within the messages, whereas others simply link to images that are fetched from a web 
site, you can use the Don’t display images that need fetching option to disable the fetching of 
images and only display images that are contained within the message.  This is useful in the case of 
junk mail because image fetches are often used to confirm that you’ve received the message and 
thus that your address is valid, increasing the likelihood of more junk mail being sent.  Selecting 
this option will prevent this confirmation from being made. 
 
Messages obeying netiquette rules will be properly formatted by the sender, but there may be 
exceptions that contain long lines that would be difficult to read without word wrapping.  The 
Automatically word wrap plain text option allows you to specify that word wrapping should be 
performed to the width of the display, removing the need to scroll horizontally. 
 
Messenger Pro can make messages easier to read by colouring sections of them depending on what 
each particular section contains.  Thus text that is quoted from preceding messages can be shown in 
a different colour, with a different colour used for each level of quoting, and signatures can also be 
shown differently from the main message text.  The Enable colouring when displaying messages 
option specifies whether or not colouring is performed.  The colours used for quotes, signatures and 
for the main text itself, URLs, and the window background, can be individually set in the bottom 
part of this dialogue.  The currently selected colour is shown next to the relevant option, clicking on 
which will bring up a colour picker allowing selection from a small range of colours, also allowing 
access to the standard colour selection dialogue should these not be sufficient. 
 
The last group of options allow you to override the display options when printing.  If you prefer, 
you may Use an alternative font when printing, perhaps one that more easily fits a message on a 
page.  To do so, enable this option and then click Change to alter the font shown.  The Message 
header font option controls the font used to print the header part of the message (the date, subject, 
sender, etc.) while the Enable colouring when printing option specifies whether message 
colouring is retained when you print a message; you may find that you want to disable this option if 
you’re not using a colour printer, for instance. 
 

Window Display Options 
 
The Window Display section contains various options that control the use and display of 
Messenger Pro’s windows.  By default, Messenger Pro will use a single window which contains a 
listing of all your groups, a group viewer capable of listing the contents of a group, and a message 
viewer capable of displaying a single message.  If you prefer, Messenger Pro can use separate 
windows for all these functions, such that you will be shown only the list of groups initially, from 
which you can open a group viewer and subsequently a message viewer by double-clicking a group 
or message respectively.  The Use separate windows for group hierarchy, group viewers and 
messages option allows you to specify this.  Alternatively, you may prefer just to show messages in 
their own window, in which case the Use a separate window for messages only option may be 
used.  To keep things tidy on-screen, Messenger Pro can automatically close these windows as you 
open new ones such that only one group window and one message window is allowed to be open at 
any one time.  The Automatically close group and message windows when another is opened 
option controls this behaviour.  Messenger Pro can also automatically Close the message window 
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when there are no more unread messages in the current group if you’d prefer it to do this rather 
than automatically move on to the next group containing unread messages when you’re using Space 
to read them. 
 

 
 
You may prefer that Messenger Pro use a specific font for its displays rather than using the same 
font used elsewhere by your computer, in which case you may select the Use a custom font option 
and select the font by clicking the Change button and selecting the font using the standard font 
selector.  Messenger Pro’s Window Colours can also be changed, as can the Text foreground 
colour, used to display messages and groups; and the Grouping bar foreground and Grouping 
bar background colours, used for displaying the headings when a message grouping is in effect. 
 

Group Options 
 
The Groups section contains options that affect the display of groups and the default settings of 
groups when new groups are created.  By default, Messenger Pro will only list groups that contain 
unread or flagged messages, unless those groups are specifically configured to be always shown 
(this means that your Inbox and certain folders are always shown, whereas newsgroups and mailing 
lists are shown only if they contain unread messages).  If you’d prefer that all groups are listed at all 
times, then you may disable the Don’t list groups containing only read messages option.  
Messenger Pro will display any flagged messages at the top of the group regardless of how they’re 
sorted, but this default can be changed using the List flagged messages before other messages 
option. 
 
When Messenger Pro displays the list of messages in a group, if threading is enabled then all the 
threads will be contracted, showing only the first message in each thread requiring expansion of the 
remaining messages.  If the Expand threads by default option is chosen, then all messages in all 
threads will be shown when the group is opened.  Threading can be further controlled by the Don’t 
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thread together messages with different subjects option, which will cause subject changes within 
a thread to be treated as a different thread and listed separately. 
 

 
 
When Messenger Pro starts up, it can be configured to display the contents of a particular group on 
startup, usually the Inbox.  This can be disabled by deselecting the Automatically display Inbox 
on startup option.  Alternatively, an alternative group can be selected by clicking Change and 
selecting the desired group from the group selector.  Note that this group is also selected when you 
double-click the inbox in the status bar. 
 
By default, Messenger Pro will fade read messages so that unread messages stand out; it will also 
fade groups containing only read messages.  The Use a faded colour for read messages option 
corresponds to this default; if you want to disable it then select List read and unread messages 
using the same colour, or if you want to set a specific colour to use for read messages, then select 
the Use a specific colour for read messages option and select the desired colour using the colour 
selector below. 
 
The Default Group Option Inheritance section allows newly created groups to inherit their group 
settings from an existing group, hence you can set up one group the way you like it and then have 
others of that type created with those same settings.  This can be configured separately for 
mailboxes, folders, mailing lists and newsgroups.  To specify a new group for each option, simply 
click Change and select the desired group. 
 

Message Options 
 
The Messages section allows you to control the handling of messages, from their arrival to their 
eventual deletion.  Messages sent by other people can be marked to be important and you can see 
these at a glance either by enabling the display of the Importance column in the group viewer, or 
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more simply by enabling the Flag messages if sender indicates them to be important option, 
which will automatically flag such messages so that you can’t miss them. 
 
The Show me new messages when they arrive option controls whether or not the new messages 
window will be displayed when new messages arrive.  You may in addition choose a sound that is 
played for new arrivals by selecting the Play sound when new messages arrive option and 
specifying the Default sound.  Clicking Change will open a file selector which will allow you to 
browse to a particular sound file, whereas Clear will clear the current selection.  Play will allow 
you to hear the currently selected sound before deciding whether or not you want to use it. 
 

 
 

The Safe attachment file extensions option controls which attachments Messenger Pro will allow 
you to open without confirmation, based on the extension that the attachment’s file name has.  If 
you open an attachment and its extension can’t be found in this list, then you will be asked to 
confirm this action.  Note that only extensions corresponding to file types that can’t contain viruses 
and can’t be used by attackers to cause your computer to do undesirable things should be added to 
this list.  Each extension should be specified including its leading dot with a comma between each 
one. 
 
Normally, Messenger Pro will move deleted messages to the waste basket instead of deleting them 
so that you have a chance to change your mind later.  If you don’t want to use the waste basket then 
you can deselect the option Move deleted messages to the waste basket to disable it.  Since it’s 
unlikely that deleted news will be recovered in future, the waste basket doesn’t apply to news unless 
the Use waste basket for deleted news option is also selected.  Also by default, Messenger Pro 
will assume that deleted messages are finished with and thus will mark them as read and unflag 
them.  To override this behaviour, deselect the Mark deleted messages as read and unflagged 
option.   
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When a message is sent, the sender can request that a receipt is generated so that he knows that it 
has been read.  Some people don’t like to do this because they then feel pressured to act on that 
message quickly knowing that the sender has been informed that they’ve already read it, but this 
facility can also be used to confirm your address to third parties whom you may not wish to know 
it, junk mailing lists, for example.  Messenger Pro allows you to choose to either never send read 
receipts, to always send them, or to ask you whenever one is requested so that you can decide on a 
per-message basis.  You may also request read receipts for messages you send by enabling the 
Always request read receipts when I send a message option. 
 

Message Editor Options 
 
The Message Editor section contains options that affect the composition of messages that you 
send.  The Default font option allows you to specify the initial font used in the send window by 
clicking Change to bring up a font selector.  The font selected here can be overridden during 
composition for rich text (HTML) messages and for plain text messages will be only used for 
display while you are editing the message – the recipient won’t see the same font when reading 
your message.  You can control whether rich text is used by using the Use rich text (HTML) for 
sending mail and Use rich text (HTML) for sending news options which set the default for mail 
and news respectively.  This choice can be overridden at composition time. 
 

 
 
The Default character set is the set of characters (i.e. letters, numbers and other symbols) that will 
be available for you to use to type your message; different languages have different character set 
requirements.  If this is left blank, Messenger Pro will attempt to determine the correct character set 
to use from the operating system, however if it gets it wrong you can tell it which one to use here.  
Clicking Change will bring up a menu of all the available character sets from which you just need 
to select the one that you want.  This option can also be overridden at composition time. 
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The Automatically word wrap text option allows Messenger Pro to word wrap your messages for 
you automatically at the specified number of characters.  This will ensure that your messages are 
readable by those people whose software doesn’t perform wrapping of received messages and will 
help your messages conform to netiquette guidelines.  This option only applies for plain text 
messages, not rich text. 
 
Usually when you send a reply, you’ll want to quote part of the original message so that you can 
refer to it and respond to specific points.  This is enabled by the Enable quoting of original 
message in replies option and is further controlled by the Quote signatures option which 
determines whether or not signatures are quoted along with the message; usually you won’t want to 
do this.  The Wrap quoted text option, if enabled, will force Messenger Pro to rewrap quoted text 
so that each line doesn’t exceed the number of characters specified above for word wrapping.  It 
does this in an intelligent way so as to tidy up multiple levels of quoting, but it can sometimes get 
this wrong and it may be preferable to perform wrapping on a paragraph by paragraph basis at 
composition time.  You can also specify whether or not the spelling checker will check quoted text 
using the Spell check quoted text option. 
 
Normally each line of quoted text is preceded by a number of characters to offset it from the rest of 
the message; usually this is a > followed by a space and it is highly recommended that the default 
be retained to maintain readability when multiple levels of quoting are used involving different 
people, but the Precede each quoted line with option allows this to be changed.  A quote is also 
usually preceded by an attribution which identifies who wrote the text being quoted.  The Precede 
personal replies with attribution is used for replies sent by e-mail, whereas the Precede group 
replies with attribution is used for group e-mail replies and follow-ups to newsgroups and mailing 
lists.  The following sequences can be included in attributions to have Messenger Pro to expand 
them as indicated: 
 

 %m – the message ID of the original message 
 %f – the From header of the original message 
 %e – the e-mail address from the From header 
 %r – the real name from the From header 
 %d – the date of the original message, e.g. 23 Jan 
 %y – the date of the original message including the year, e.g. 23 Jan 2003 
 %t – the time of the original message, e.g. 11:21 
 %n – a new line 
 %% - a percent % character 

 
When editing a message, Messenger Pro can automatically save a copy of the message every so 
often, in case of a power cut or system crash.  This facility is controlled using the Automatically 
save a draft of edited messages every option, which can be enabled or disabled and have an 
interval specified as a number of seconds between saves.  Finally, the Language used for spell 
checking may be configured here by clicking Change and selecting the desired language from the 
menu.  Currently English (British) and English (American) dictionaries are supported but more 
may be added in the future. 
 

Sending Message Options 
 
The Sending Messages section contains options which affect the sending of messages.  When you 
send a message, Messenger Pro will normally transfer the sent message straightaway but you can 
control this using the Automatically transfer messages when sent option.  The When replying, 
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automatically add addresses to the address book option allows the address book to automatically 
keep track of the addresses of people whose messages you reply to, which is a convenient way of 
building up a list of your correspondents without having to manually enter each one.  When 
replying to messages, you can also Automatically unflag messages when a reply is sent, to 
remove the flagged status of a message you’re replying to so that it no longer appears to need 
attention. 
 
Use of the Sent Mail and Sent News folders can be configured by specifying whether or not to 
Keep copies of sent mail and Keep copies of sent news.  Such copies can also be automatically 
marked as read so that they don’t interfere with the folders’ unread message counts by selecting the 
Mark filed copies of sent messages as read option; the actual sent copy in your Outbox is 
controlled by the Mark sent messages as read option.  The Keep copies of bounced mail option 
applies when bouncing copies of messages to other people. 
 

 
 

Attachments can be sent in one of three formats and the Default Encoding for Mail Attachments 
and Default Encoding for News Attachments options allow this to be configured separately for 
mail and news.  The default of MIME for mail is highly recommended, but UUCode can be 
specified if you regularly communicate with people with out of date software that doesn’t 
understand MIME.  For news, the default of UUCode is recommended since many old newsreaders 
don’t contain MIME support, but the option to use MIME is included.  YEnc is a newer encoding 
which is more efficient (it results in a reduced message size) but only very recent newsreaders will 
contain support for it. 
 

Encryption and Signing Options 
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The Encryption and Signing section contains options affecting Messenger Pro’s interaction with 
GnuPG, which can increase the security of the messages you send and receive by encrypting 
sensitive messages and signing messages so that their authenticity can be verified. 
 
The Sign all private correspondence option will ensure that all private (e-mailed) messages you 
send are signed with your private key using GnuPG.  The Sign all messages sent to public forums 
option is the corresponding option for messages sent to newsgroups and mailing lists.  Encrypt all 
private correspondence can be used in a similar way to encrypt all e-mail you send. 
 
Messenger Pro can be configured to Automatically verify signed messages so that you don’t need 
to perform a verification of every signed message you receive.  This is enabled by default but you 
may like to disable it if you receive a lot of signed mail for which you don’t have the public keys 
corresponding to their senders and/or you don’t want to waste time on the verification when you’re 
not interested in the result.  If you are security conscious, then you may wish to insist that all keys 
in your keyring are signed by a third party to assert that they belong to the persons they claim to 
belong to; alternatively, you may enable the Trust that all keys belong to their claimed owners to 
prevent signature verifications from failing where the keys aren’t signed by others.  You may also 
have GnuPG automatically download public keys from a public key server, as specified by the Use 
key server option, if you enable the Download public keys automatically option. 
 

 
 
Messenger Pro can be configured to Remember passphrases for a certain amount of time so that 
you don’t have to keep entering them.  This makes things convenient for you but may be considered 
a potential security risk because if you leave your machine unattended then somebody could use 
your private key to sign or decrypt messages in your absence.  If you do want to make use of this 
option, simply enter the number of minutes you’d like your key to be remembered for.  The time is 
measured from the last use of the key, not from when the passphrase was originally entered.  
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Finally, to aid in tracking down problems with GnuPG, the Log output from GnuPG option can be 
enabled which will log any output from GnuPG to Messenger Pro’s main log. 
 

Netiquette and Confirmation Options 
 
The Netiquette and Confirmations sections allow various warnings and confirmation questions 
that Messenger Pro asks to be disabled.  Simply uncheck the desired warning or confirmation to 
disable it. 
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Calendar Options 
 
The Calendar section includes options that relate to the use of the calendar in Messenger Pro.  At 
present this is limited to a definition of the hours you work each day which allows the day view to 
highlight these hours appropriately.  Simply tick the days you work and then enter the start and end 
times for each workday. 
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Transfer Options 
 
The Transfers section contains options that control the transfer of messages at the communication 
level.  The Indicate transfer errors unobtrusively option specifies that errors that occur during 
the transfer of message should be silently indicated using the transfer status indicator at the bottom 
of the window, with further details logged to the transfer error window.  If you’d prefer to also see 
an error message when a transfer error occurs, then you can deselect this option.  The Limit 
transfers to option enables you to control how many accounts can be active transferring messages 
at any one time; if you have more accounts than this then some will be queued until others have 
finished, so that this limit is not exceeded. 
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The Don’t send mail messages to more than option controls how many recipients can be specified 
in a single SMTP transaction.  Mail servers are required to support at least 100 but no more than 
this can be guaranteed so the default of 100 is highly recommended, although most people will be 
unlikely to send messages to so many different addresses.  However, if your local mail server is 
rejecting your messages for containing too many recipients then you may need to reduce this value.  
When you subscribe to a new newsgroup, Messenger Pro will fetch so many existing messages 
before only fetching new ones.  This number is specified by the When fetching a new newsgroup, 
fetch an initial option. 
 
Messenger Pro logs transfer activity to separate logs, one per account, but a global application log 
can also be kept which will also log details of filter matches and other events.  The Enable global 
logging option specifies whether or not this is enabled.  If you want transfer logs to also be logged 
to the global log, you can enable the Include transfer logs in global log option.  Also here you can 
specify the maximum size of the global log and of each of the transfer logs. 
 

Application Options 
 
Linux users will see an additional section which allows them to specify which applications are used 
to launch HTTP and FTP URLs, and how to play sound files.  Simply enter the command line for 
the required application with %s representing the position of the URL or file.  Also shown is the 
command line used to display this manual which can be changed as required. 
 

Advanced Options 
 
The Advanced section contains options that most users will not need to use but are provided for 
more experienced users to fine tune Messenger Pro to suit their requirements. 
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Under Windows, Messenger Pro will automatically detect your proxy settings for use when 
fetching images and checking for updates, but Linux users need to specify this explicitly; Windows 
users may override the system default if they choose.  The option Use proxy server for web 
requests controls which proxy server is used with an optional Port number defaulting to 80 if left 
blank. 
 
The Default directory is the directory Messenger Pro will start in whenever you want to save or 
open a file.  Under Windows this will usually be My Documents and under Linux it’ll be your 
home directory, but you may override this choice by using this option. 
 
At the bottom of the window are a number of miscellaneous advanced options.  The Automatically 
perform message transfers option specifies whether or not Messenger Pro will periodically check 
for new messages or whether you have to do this manually, and the Open transfer status window 
whenever a transfer occurs allows you to specify whether or not you want to see the status of 
transfers as they happen, opening the window when a fetch starts and closing it when all fetches 
have finished; alternatively, Messenger Pro can show you the transfer window when you click on 
the Send/Receive button and leave it on screen, by enabling the Open transfer status window 
when clicking Send/Receive button option. 
 
When you leave a group (by selecting another one or by clicking on a heading in the group 
hierarchy), the Clear message pane when leaving groups option controls whether or not the 
message pane is cleared or left as it is.  Group and message viewers can optionally display the full 
path names of folders by setting the Display the full path names of folders option.  Doing so will 
show the name of the folder’s parent and its parent and so on, all the way to the top of the hierarchy.  
The listing of messages can be controlled using the Strip reply prefixes when displaying subjects 
option – enabling this will remove any Re: prefixes that appear in message subjects, which some 
may find beneficial to the display. 
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By default the address book is sorted by surname, but you can sort it by first name by enabling Sort 
contact names by first name.  If you are using the Windows version and find that Messenger Pro 
reports that you are offline when you’re not, especially on a permanent Internet connection, then 
you can enable the option Ignore online status reported by Windows which forces Messenger 
Pro to ignore the incorrect information it is receiving from Windows about your online status. 
 
The Automatically check for new versions of Messenger Pro option determines whether 
Messenger Pro will check for new versions of itself on startup or whether you need to force it to do 
this.  Under Windows, you can make Messenger Pro Check that Messenger Pro is your default 
mail client on startup and Check that Messenger Pro is your default news client on startup to 
ensure that URL handling and file type associations are set up and registered for Messenger Pro.  If 
you don’t want Messenger Pro to handle these and want to prevent it from asking if you want it to 
each time you start it up then you’ll want to disable these options.  The option File replies in the 
same folder as the original message option ensures that copies of replies are kept together with 
their original messages. 
 
By default, Messenger Pro will only post news messages to servers that carry all the newsgroups 
you’re trying to post to, but this may be overridden by deselecting the option Only post to servers 
that carry all newsgroups being posted to.  The Enable editing of headers by default option 
specifies whether header editing is enabled by default in the send window.  Unless you routinely 
edit the headers of outgoing messages then you’ll want to leave this option disabled. 
 
The Cache results of DNS lookups option allows Messenger Pro to remember the IP addresses of 
your mail and news servers so that it doesn’t have to keep looking them up every time it makes a 
connection.  You’ll usually want to leave this option enabled to benefit from the speed advantage of 
caching. 
 
The Ensure mail is saved to disk immediately after download and Ensure news is saved to disk 
immediately after download options specify whether Messenger Pro forces a write to disk 
following the download of each message, which is slow but guarantees the message is saved in case 
of problems, or allows several writes to be buffered in memory before writing, which is faster but 
less safe.  The default for mail is safety while news is speed but either can be changed.   
 
Normally, each message you receive will have a unique message ID and Messenger Pro assumes 
this when threading and performing lookups by message ID.  Sometimes, however, you may 
receive messages that have the same ID, due to some error along the transmission path, which can 
cause some confusion.  Messenger Pro therefore has a Hide duplicate message IDs when opening 
groups option which will automatically mark duplicate messages as read and hide them when you 
open groups containing such messages. 
 
If you’ve configured Messenger Pro to use a separate message window, then the Close message 
window when sending a reply option allows this window to be automatically closed when you 
reply to the message currently being displayed, thereby replacing it with the reply window.  The 
Don’t allow double-clicks to open groups and messages option may be useful when separate 
windows aren’t being used, disabling the ability to open groups and messages in a new window by 
double-clicking them.  
 
The Keep mail batches indefinitely option refers to the storage of files used by the batch file 
account type.  Normally Messenger Pro will automatically delete such files after importing them, 
but disabling this option will keep a copy inside Messenger Pro’s data directory which may be 
useful for diagnostic purposes. 
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The Force use of quoted-printable encoding option should only be used if your messages are sent 
via a mail gateway which MIME encodes all non-encoded messages and does this unreliably under 
certain circumstances.  It is very unlikely that you’ll need to use this option.  You may, on the other 
hand, need to use the Use non-standard encoding of international characters in attachment 
names option if you send attachments containing international characters in their file names to 
recipients whose mail software doesn’t understand the standard encoding that Messenger Pro uses 
(i.e. that described in RFC 2231).  Enabling this option forces Messenger Pro to use a non-standard 
and technically invalid encoding but which may be understood by software which doesn’t conform 
to the documented specification.  You should only enable this option if your recipients complain 
about not being able to extract the attachments you send them (and the attachments contain 
international characters). 
 
The Filter non-ASCII characters when displaying message source option ensures that only ASCII 
characters are displayed in the message viewer when viewing the message source, stripping any 
non-ASCII characters.  This should only be used if you want to copy the source to something which 
doesn’t cope with non-ASCII characters.  Finally, the Indicate unread and queued mail in the 
system tray option controls whether or not icons will appear in the system tray to indicate when 
there’s unread mail in your Inbox or mail in your Outbox waiting to be sent; these icons are enabled 
by default. 
 

Advanced Features 

Customizing the Toolbar 
 
The buttons displayed in the toolbar can be customized by selecting the Customize option which is 
on the Toolbars submenu of the View menu.  This applies to all of Messenger Pro’s windows that 
contain toolbars. 
 

 
 
The first option is Toolbar which allows you to select which toolbar you want to edit from a menu 
(the main toolbar is selected by default).  You’ll see a list of all available actions (i.e. buttons) that 
can be assigned to the toolbar on the left, and the toolbar’s current actions on the right.  The current 
actions are shown in the same order in which they’ll appear on the toolbar and can be reordered by 
selecting an action (or separator) and using the Move Up and Move Down buttons to reposition it. 
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To add an action to the toolbar, select the desired action on the left and click the Add button; 
similarly, to add a separator (i.e. a dividing line which allows you to group buttons together) click 
the Add Separator button.  The new action appears at the bottom of the list, but can be moved into 
its desired position as described above.  To remove an action that’s no longer required, simply 
select it on the right and click the Remove button. 
 
Once finished, click OK to save your changes or Cancel to restore your previous toolbar 
configuration. 
 

Customizing Keyboard Shortcuts 
 
Messenger Pro’s keyboard shortcuts can also be customized, using the Keyboard Shortcuts option 
on the Tools menu.  You can then assign a shortcut to any option in Messenger Pro’s menus, or 
change existing shortcuts. 
  

 
 

On the left is a tree representing Messenger Pro’s menu structure; on the right appear the shortcuts 
currently assigned to each option.  To change a shortcut, simply select the option you want to 
change and type the shortcut you want to assign to it.  Note that in order to allow keyboard 
navigation of the menu tree, certain keys can’t be used to assign shortcuts in this way; therefore, as 
an alternative, you can click the Shortcut field at the bottom of the window, causing it to highlight, 
and then type the desired shortcut. 
 
If you deselect the option Group options to reflect menu structure, a simple listing of options and 
shortcuts will be used allowing you to sort the options alphabetically by name or by shortcut by 
clicking on the column headings. 
 
Clicking OK will save your changes and apply the shortcuts immediately. 
 

Viewing and Editing Message Source 
 
The Message Source option in the message viewer will display the raw text of the message in full, 
exactly as it was received by Messenger Pro, including its full header and any MIME headers and 
boundaries.  This is only useful for advanced users who have an understanding of message headers 
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and are looking for something in particular that isn’t otherwise displayed.  Normally the 
information displayed in the header pane will be sufficient for most users. 
 
Any messages stored within Messenger Pro’s database (with the exception of messages stored on 
remote IMAP servers) may have their source edited so that changes can be made to them and then 
saved back.  This can be useful when archiving messages as it allows annotations to be made or for 
irrelevant material to be stripped out before archiving. 
 
To edit the current message, select Edit Message from the Message menu.  You will be presented 
with the source of the message which will be editable, allowing you to make any changes you 
require.  Selecting this option again will end the edit, prompting you to save or discard any changes 
made.  Selecting Save from the File menu during the edit will also save the changes. 
 

Message Utilities 
 
The Utilities submenu on the Message menu of the message viewer allows you to create Messenger 
Pro objects, e.g., filters and contacts, based on the current message.  Create Filter from Messages 
will look at the current message, or selection of messages, and attempt to find any characteristics 
that they share, so that a filter can be created to recognise them.  Create Mailing List from 
Message will look at the current message and attempt to create a mailing list that has the right 
name, posting address and filtering criteria to successfully set up a mailing list group for future 
messages received from the same mailing list.  Add Sender to Address Book will create a new 
contact for your address book using the message sender’s details.  The plus icon to the left of the 
sender in the header pane will also select this option.  Add Sender to Approved Sender List will 
similarly create an entry for the current sender in the list of addresses consulted during junk filtering 
(displayed in the Junk Mail Filtering window), preventing messages sent by that sender from being 
filtered. 
 
It is also possible to set up kill rules, i.e. filters, to block any future messages received from the 
current message sender, or with the same subject, using the Add Kill Rule for this Sender and 
Add Kill Rule for this Subject options.  The cross button next to the sender and subject in the 
header pane will also do this.  Finally, the Add Kill Rule for Descendants will block any replies to 
the current message.  In all three cases, a suitable filter will be created which marks blocked 
messages as read, bringing up the filter properties editor for the created filter so that you can make 
any changes that may be required. 
 

URLs 
 
Messenger Pro will highlight any URLs, e-mail addresses or message IDs appearing in messages 
allowing you to click on them to launch them.  Clicking on a URL will launch it in your web 
browser, whereas Shift-clicking it will record the URL for opening later.  A selection of text can 
also be launched as a URL by selecting Launch URL from the Edit menu.  This then allows the 
URL to be edited before launching. 
 
It isn’t generally possible to automatically distinguish between an e-mail address and a message ID 
since they have the same format, so Messenger Pro will treat clicks on either as an attempt to send 
mail to an e-mail address, opening a send window with the address filled in, and a Shift-click as an 
attempt to view a message from its ID.  This will bring up a menu allowing you to View Message 
which will display the message if Messenger Pro already has it, View Message using Google 
which will use Google Groups (http://groups.google.com/) to attempt to find the message in its 
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archive, or View Message using Google (Defer) which will do the same but generate a URL for 
future launching rather than display it immediately. 
 
Any saved URLs may be viewed by selecting URLs from the Tools menu in the main window. 
 

 
 
Selecting a URL and clicking Launch will launch the URL in a browser.  URLs can then be 
removed by clicking Remove and edited using Edit.  New URLs can also be added using Add.  
Adding and editing both make use of the URL properties editor which allows you to enter a URL 
and a description to go with it. 
 

 

Importing & Exporting Messages 
 
Messenger Pro can import messages from mail or news batch files created by other mail and news 
software that are in standard mailbox or mail/news batch format (mbox, rmail, rnews format, etc.).  
This provides a convenient way to transfer messages from your existing software into Messenger 
Pro.  Similarly, you can export messages from Messenger Pro to other software via the same types 
of batch file. 
 
To import one or more batch files, select the Import Messages option from the File menu.  You’ll 
be asked to specify the names of the files which you want to import using a standard file selector, 
and then how you want to handle the import. 
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For mail batches, you’ll generally want to import the messages into a folder, so the I want to 
import messages to a specific group option should be chosen and the desired folder selected by 
clicking Change and selecting the group from the group selector.  Alternatively, for news batches, 
you may want Messenger Pro to put the messages in the right groups by looking at their 
Newsgroups headers, in which case you should select the I want the file to be debatched into 
newsgroups as appropriate option.  You can also optionally Apply incoming mail filters to 
imported messages or Apply incoming news filters to imported messages but both these options 
default to off. 
 
Exporting to a batch file is a simple matter of selecting the groups or messages you want to export 
and then choosing the Export Messages option, also on the File menu.  After selecting the name of 
the file to export to, you’ll be asked what format the batch file needs to be in.  In most cases the 
default UNIX mailbox (mbox) format will suffice which is the most likely format to be supported 
by other software, but other options are available should you have a requirement for any of them.  
After selecting the format, all the selected groups or messages will be exported to the file in this 
format. 
 

 
 

Importing and Exporting Contacts 
 

The Windows version of Messenger Pro provides support for importing existing contacts from 
Outlook or the Windows Address Book.  To do this, click on Import in the address book window 
and then From Outlook or From Windows Address Book depending on which you want to 
import from.  Messenger Pro will then connect to the address book and display a list of all contacts 
it finds. 
 
If you’re importing from Outlook, you may receive a warning that a program is trying to access 
Outlook’s e-mail addresses.  This is a security precaution added to safeguard against viruses, 
however since in this instance it is Messenger Pro that requires this access, you need to allow it by 
ticking the Allow access for check box and choosing a suitable time interval; an import is unlikely 
to take more than 5 minutes and will usually be considerably quicker than this, so this is the 
suggested setting.  Click Yes to continue. 

 
Those contacts that don’t already appear in your address book are automatically selected ready for 
import, but you can deselect contacts or manually select additional contacts by using the check box 
next to the contact’s name.  The Select All button will conveniently allow you to select all contacts 
for import, while Unselect All will unselect them.  When you’re happy with the selection, you can 
press Import Selected to copy the selected contacts to your address book, and finally Close to close 
the import window. 
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Users of the RISC OS versions of Messenger Pro and Pluto, or of Forté Agent may also import 
their existing address books by clicking Import, choosing From Messenger Pro (RISC OS), 
From Pluto CSV (RISC OS) or From Agent from the pop-up menu and then selecting the address 
book file from the file selector. 
 
vCards (a standard file format for exchanging contact information) may be imported by selecting 
the From vCard(s) option from the import menu, and exported by clicking Export and selecting 
the required format (version 3.0 or 2.1) from the pop up menu. 
 
Additionally, Messenger Pro has the capability of importing contacts from an LDAP server.  
Simply select the From IMAP Server option from the import menu, complete the details of your 
server and click Search to list all available contacts.  You may then select and import contacts as 
required. 
 

 
 

Database Maintenance 
 
Messenger Pro’s database should need no maintenance as it looks after it itself.  However, in the 
event of problems or system crashes, inconsistencies in the database may develop which manifest 
themselves as unexpected behaviour or random errors.  In these situations, Messenger Pro offers 
facilities for repairing the database which should hopefully cure these problems.  These facilities 
appear on the Database Maintenance submenu off the main Tools menu. 
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The first thing to try, if the problem seems isolated to one or a few particular groups, is to select the 
group(s) in the hierarchy viewer and select the Repair Groups option.  This will scan each group’s 
files for anything that looks like a message and rebuild the group with any messages it finds.  You 
may receive a warning about messages being lost – this refers to blocks of data which initially 
looked like messages but couldn’t be fully retrieved.  This may indicate data loss but this may also 
occur naturally as old, random data is found in the files, perhaps from deleted messages, so the 
warning should be treated as a warning to check the group’s contents yourself since no messages 
may have been lost after all.  The Repair Groups option will skip any messages it finds that you 
yourself have deleted; if you want to recover deleted messages then the alternative Repair Groups 
(Undelete) option may be used which considers all messages. 
 
If a group disappears from the display and can’t be found, you can have Messenger Pro Scan for 
Lost Groups to see whether it still exists within the database and has simply been omitted from 
Messenger Pro’s master index.  If any groups are found, you will be asked whether you want to 
keep them or delete them; deleting may be the right choice if old deleted groups are appearing 
which weren’t deleted successfully the first time for whatever reason. 
 
If accessing messages using the thread menu doesn’t work properly, or you’re seeing duplicate 
messages, then Messenger Pro’s message ID index may be corrupted, in which case the Rebuild 
Message ID Index option will scan all groups and messages to rebuild the index. 
 

Message History 
 
Messenger Pro maintains a list of the last 100 messages you’ve read which can be useful if you 
remember reading something but have since left the group in which you read it and can’t remember 
where it was.  The history window is opened by selecting Reopen Message from the Go menu. 
 

 
 

Bouncing Messages 
 
Bouncing is a subtle variation on forwarding a message – instead of encapsulating the original 
message in a new message, the original message itself is resent, preserving all content and headers.  
It will therefore appear to have come from the original sender with the original subject and date.  
For this reason, when you bounce a message there are no editing facilities available – you can only 
choose where to send it (the Resend To field) and the identity you’re sending it from (the Resend 
From field).  This information will be included in the headers of the new message, but apart from 
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this (and any new headers added during mail transport), the new header will be identical to the old 
and will appear to the new recipient exactly as it did to you. 
 

 
 

Templates 
 
Templates are a means to set up standard responses to messages which can be quickly selected from 
a menu, automatically filling in details from the message along with fixed text that you’ve entered.  
The send window is used to edit templates, with the File | Save as Template menu option used to 
save the current message for future use as a template. 
 
To include content from the message you’re responding to, you need to insert one of the following 
macros available from the Insert | Macro menu: 
 

 %SUBJECT – the subject of the original message 
 
 %BODY – the unquoted body from the original message 

o %BODY[QUOTED] – the quoted body 
 

 %HEADER – the full header from the original message 
o %HEADER[field] – the contents of the specific header field 
 

 %MESSAGEID – the message ID from the original message 
 
 %FROM – the from header from the original message 

o %FROM[NAME] – the name part of the from header 
o %FROM[ADDRESS] – the address part of the from header 
 

 %SENDER – the sender header from the original message 
o %SENDER[NAME] – the name part of the sender header 
o %SENDER[ADDRESS] – the address part of the sender header 
 

 %REPLYTO – the reply-to header from the original message 
o %REPLYTO[NAME] – the name part of the reply-to header 
o %REPLYTO[ADDRESS] – the address part of the reply-to header 
 

 %ORGANIZATION – the organization header from the original message 
 
 %TO – the to header from the original message 

o %TO[NAME] – the name part(s) of the to header 
o %TO[ADDRESS] – the address part(s) of the to header 
 

 %CC – the cc header from the original message 
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o %CC[NAME] – the name part(s) of the cc header 
o %CC[ADDRESS] – the address part(s) of the cc header 
 

 %BCC – the bcc header from the original message 
o %BCC[NAME] – the name part(s) of the bcc header 
o %BCC[ADDRESS] – the address part(s) of the bcc header 
 

 %IDENTITY – the identity of the original message 
o %IDENTITY[NAME] – the name part of the identity 
o %IDENTITY[ADDRESS] – the address part of the identity 
 

 %NEWSGROUPS – the newsgroups header from the original message 
 %FOLLOWUPTO – the followup-to header from the original message 
 
 %DATE – the date header from the original message 

o %DATE[format] – the date expressed using format format 
 

 %NOW – the current date and time 
o %NOW[format] – the current date and time expressed using format format 
 

 %GEMINIVERSION – the current version of Messenger Pro 
 %QTVERSION – the version of Qt used by Messenger Pro 
 %PLATFORM – the platform you’re using Messenger Pro on (i.e. Windows or Linux) 

 
Note that due to the use of the % character to start a macro, the sequence %% must be used to 
include a percent character in your message.  The following expressions can be used in date 
formats: 
 

 d – the day as number without a leading zero (1-31) 
 dd – the day as number with a leading zero (01-31) 
 ddd – the abbreviated day name (e.g. 'Mon'..'Sun') 
 dddd – the long day name (e.g. 'Monday'..'Sunday') 
 M – the month as number without a leading zero (1-12) 
 MM – the month as number with a leading zero (01-12) 
 MMM – the abbreviated month name (e.g. 'Jan'..'Dec') 
 MMMM – the long month name (e.g. 'January'..'December') 
 yy – the year as two digit number (00-99) 
 yyyy – the year as four digit number (1752-8000) 
 h – the hour without a leading zero (0..23 or 1..12 if AM/PM display) 
 hh – the hour with a leading zero (00..23 or 01..12 if AM/PM display) 
 m – the minute without a leading zero (0..59) 
 mm – the minute with a leading zero (00..59) 
 s – the second without a leading zero (0..59) 
 ss – the second with a leading zero (00..59) 
 z – the milliseconds without leading zeroes (0..999) 
 zzz – the milliseconds with leading zeroes (000..999) 
 AP – use AM/PM display. AP will be replaced by either "AM" or "PM" 
 ap – use am/pm display. ap will be replaced by either "am" or "pm" 
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Once saved, templates can be used by selecting the Message | Other Send Operations | Respond 
using Template option, to respond to a specific message, or the File | New | Mail Message using 
Template option, to send a new message based on a template.  Both these options should be 
selected from the main window menu. 
 
Also available from the main window menu is the option Tools | Templates which gives a listing of 
all saved templates. 
 

 
 

From here, you may create a new template by clicking Add or edit an existing one using Edit.  In 
both cases the send window will be opened as a template editor with the restriction that the facility 
to send messages is not available.  Templates can also be deleted using the Remove button. 

 

The Keyring Window 
 
Messenger Pro supports the GnuPG public key encryption system (see http://www.gnupg.org/ for 
more details including how to install it for use with Messenger Pro).  Selecting Keyring from the 
Tools menu will open the keyring window displaying all keys currently in your keyring.  This 
window allows you to perform basic management functions on your keyring. 
 
Each key will normally be depicted by an icon containing a black key, but if a key has been revoked 
then it will have a red line drawn through it.  Selecting a key and clicking Remove will permanently 
delete it from your keyring.  You can also import keys by clicking Import and selecting a file to 
import from and Export to a file too. 

Updates 
 
Messenger Pro is capable of checking its web site for newer versions and alerting you if one is 
available.  By default, this must be done manually by selecting Check for Updates from the Help 
menu, but a check may be made each time you start Messenger Pro by enabling the relevant option 
in the main options window.  If a newer version is available then you will be prompted to visit the 
web site to download it or to view its list of changes.  You can also tell Messenger Pro to ignore the 
newer version and you won’t be prompted until the next version is released. 
 
You can determine the current version of Messenger Pro that you are using by using the About 
Messenger Pro option on the Help menu. 
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Launching From Third Party Applications 
 
Messenger Pro can be launched from third-party applications, web browsers for example, to 
automatically start a send session based on information in that application, such as an e-mail 
address or partial message.  Such applications usually allow a mail client’s command line to be 
specified in their configuration, which should be one of the following: 
 

messengerpro –url %s 
 
to launch a URL, usually beginning with mailto:, or just: 
 

messengerpro –email %s 
 
to send a message to a particular e-mail address.  In both cases, %s needs to be replaced by whatever 
the application uses to identity the particular URL or e-mail address being passed to Messenger Pro. 
 
This is not usually required on the Windows or Mac OS X platforms. 
 

Acknowledgements 

OpenSSL 
 
Copyright (c) 1998-2003 The OpenSSL Project.  All rights reserved. 
 
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions 
are met: 
 
1. Redistributions of source code must retain the above copyright 
   notice, this list of conditions and the following disclaimer.  
 
2. Redistributions in binary form must reproduce the above copyright 
   notice, this list of conditions and the following disclaimer in 
   the documentation and/or other materials provided with the 
   distribution. 
 
3. All advertising materials mentioning features or use of this 
   software must display the following acknowledgment: 
   "This product includes software developed by the OpenSSL Project 
   for use in the OpenSSL Toolkit. (http://www.openssl.org/)" 
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4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to 
   endorse or promote products derived from this software without 
   prior written permission. For written permission, please contact 
   openssl-core@openssl.org. 
 
5. Products derived from this software may not be called "OpenSSL" 
   nor may "OpenSSL" appear in their names without prior written 
   permission of the OpenSSL Project. 
 
6. Redistributions of any form whatsoever must retain the following 
   acknowledgment: 
   "This product includes software developed by the OpenSSL Project 
   for use in the OpenSSL Toolkit (http://www.openssl.org/)" 
 
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR 
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. 
==================================================================== 
 
This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com).  This product includes software written by Tim 
Hudson (tjh@cryptsoft.com). 
 

SSLeay 
 
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) 
All rights reserved. 
 
This package is an SSL implementation written 
by Eric Young (eay@cryptsoft.com). 
The implementation was written so as to conform with Netscapes SSL. 
  
This library is free for commercial and non-commercial use as long as 
the following conditions are aheared to.  The following conditions 
apply to all code found in this distribution, be it the RC4, RSA, 
lhash, DES, etc., code; not just the SSL code.  The SSL documentation 
included with this distribution is covered by the same copyright terms 
except that the holder is Tim Hudson (tjh@cryptsoft.com). 
  
Copyright remains Eric Young's, and as such any Copyright notices in 
the code are not to be removed. 
If this package is used in a product, Eric Young should be given attribution 
as the author of the parts of the library used. 
This can be in the form of a textual message at program startup or 
in documentation (online or textual) provided with the package. 
  
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions 
are met: 
1. Redistributions of source code must retain the copyright 
   notice, this list of conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright 
   notice, this list of conditions and the following disclaimer in the 
   documentation and/or other materials provided with the distribution. 
3. All advertising materials mentioning features or use of this software 
   must display the following acknowledgement: 
   "This product includes cryptographic software written by 
    Eric Young (eay@cryptsoft.com)" 
   The word 'cryptographic' can be left out if the rouines from the library 
   being used are not cryptographic related :-). 
4. If you include any Windows specific code (or a derivative thereof) from  
   the apps directory (application code) you must include an acknowledgement: 
   "This product includes software written by Tim Hudson (tjh@cryptsoft.com)" 
  
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
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ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE. 
  
The licence and distribution terms for any publically available version or 
derivative of this code cannot be changed.  i.e. this code cannot simply be 
copied and put under another distribution licence 
[including the GNU Public Licence.] 
 

Qt 
 
The Qt GUI Toolkit is Copyright (C) 2009 Nokia Corporation and/or its subsidiary(-ies). 
Contact: Qt Software Information (qt-info@nokia.com) 
Qt is available under the LGPL. 
The GNU Lesser General Public License (Version 2.1) 
Reference: GNU Lesser General Public License, version 2.1 
                   GNU LESSER GENERAL PUBLIC LICENSE 
                        Version 2.1, February 1999 
 
  Copyright (C) 1991, 1999 Free Software Foundation, Inc. 
  51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA 
  Everyone is permitted to copy and distribute verbatim copies 
  of this license document, but changing it is not allowed. 
 
 [This is the first released version of the Lesser GPL.  It also counts 
  as the successor of the GNU Library Public License, version 2, hence 
  the version number 2.1.] 
 
                             Preamble 
 
   The licenses for most software are designed to take away your 
 freedom to share and change it.  By contrast, the GNU General Public 
 Licenses are intended to guarantee your freedom to share and change 
 free software--to make sure the software is free for all its users. 
 
   This license, the Lesser General Public License, applies to some 
 specially designated software packages--typically libraries--of the 
 Free Software Foundation and other authors who decide to use it.  You 
 can use it too, but we suggest you first think carefully about whether 
 this license or the ordinary General Public License is the better 
 strategy to use in any particular case, based on the explanations below. 
 
   When we speak of free software, we are referring to freedom of use, 
 not price.  Our General Public Licenses are designed to make sure that 
 you have the freedom to distribute copies of free software (and charge 
 for this service if you wish); that you receive source code or can get 
 it if you want it; that you can change the software and use pieces of 
 it in new free programs; and that you are informed that you can do 
 these things. 
 
   To protect your rights, we need to make restrictions that forbid 
 distributors to deny you these rights or to ask you to surrender these 
 rights.  These restrictions translate to certain responsibilities for 
 you if you distribute copies of the library or if you modify it. 
 
   For example, if you distribute copies of the library, whether gratis 
 or for a fee, you must give the recipients all the rights that we gave 
 you.  You must make sure that they, too, receive or can get the source 
 code.  If you link other code with the library, you must provide 
 complete object files to the recipients, so that they can relink them 
 with the library after making changes to the library and recompiling 
 it.  And you must show them these terms so they know their rights. 
 
   We protect your rights with a two-step method: (1) we copyright the 
 library, and (2) we offer you this license, which gives you legal 
 permission to copy, distribute and/or modify the library. 
 
   To protect each distributor, we want to make it very clear that 
 there is no warranty for the free library.  Also, if the library is 
 modified by someone else and passed on, the recipients should know 
 that what they have is not the original version, so that the original 
 author's reputation will not be affected by problems that might be 
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 introduced by others. 
  
   Finally, software patents pose a constant threat to the existence of 
 any free program.  We wish to make sure that a company cannot 
 effectively restrict the users of a free program by obtaining a 
 restrictive license from a patent holder.  Therefore, we insist that 
 any patent license obtained for a version of the library must be 
 consistent with the full freedom of use specified in this license. 
 
   Most GNU software, including some libraries, is covered by the 
 ordinary GNU General Public License.  This license, the GNU Lesser 
 General Public License, applies to certain designated libraries, and 
 is quite different from the ordinary General Public License.  We use 
 this license for certain libraries in order to permit linking those 
 libraries into non-free programs. 
 
   When a program is linked with a library, whether statically or using 
 a shared library, the combination of the two is legally speaking a 
 combined work, a derivative of the original library.  The ordinary 
 General Public License therefore permits such linking only if the 
 entire combination fits its criteria of freedom.  The Lesser General 
 Public License permits more lax criteria for linking other code with 
 the library. 
 
   We call this license the "Lesser" General Public License because it 
 does Less to protect the user's freedom than the ordinary General 
 Public License.  It also provides other free software developers Less 
 of an advantage over competing non-free programs.  These disadvantages 
 are the reason we use the ordinary General Public License for many 
 libraries.  However, the Lesser license provides advantages in certain 
 special circumstances. 
 
   For example, on rare occasions, there may be a special need to 
 encourage the widest possible use of a certain library, so that it becomes 
 a de-facto standard.  To achieve this, non-free programs must be 
 allowed to use the library.  A more frequent case is that a free 
 library does the same job as widely used non-free libraries.  In this 
 case, there is little to gain by limiting the free library to free 
 software only, so we use the Lesser General Public License. 
 
   In other cases, permission to use a particular library in non-free 
 programs enables a greater number of people to use a large body of 
 free software.  For example, permission to use the GNU C Library in 
 non-free programs enables many more people to use the whole GNU 
 operating system, as well as its variant, the GNU/Linux operating 
 system. 
 
   Although the Lesser General Public License is Less protective of the 
 users' freedom, it does ensure that the user of a program that is 
 linked with the Library has the freedom and the wherewithal to run 
 that program using a modified version of the Library. 
 
   The precise terms and conditions for copying, distribution and 
 modification follow.  Pay close attention to the difference between a 
 "work based on the library" and a "work that uses the library".  The 
 former contains code derived from the library, whereas the latter must 
 be combined with the library in order to run. 
  
                   GNU LESSER GENERAL PUBLIC LICENSE 
    TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
 
   0. This License Agreement applies to any software library or other 
 program which contains a notice placed by the copyright holder or 
 other authorized party saying it may be distributed under the terms of 
 this Lesser General Public License (also called "this License"). 
 Each licensee is addressed as "you". 
 
   A "library" means a collection of software functions and/or data 
 prepared so as to be conveniently linked with application programs 
 (which use some of those functions and data) to form executables. 
 
   The "Library", below, refers to any such software library or work 
 which has been distributed under these terms.  A "work based on the 
 Library" means either the Library or any derivative work under 
 copyright law: that is to say, a work containing the Library or a 
 portion of it, either verbatim or with modifications and/or translated 
 straightforwardly into another language.  (Hereinafter, translation is 
 included without limitation in the term "modification".) 
 
   "Source code" for a work means the preferred form of the work for 
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 making modifications to it.  For a library, complete source code means 
 all the source code for all modules it contains, plus any associated 
 interface definition files, plus the scripts used to control compilation 
 and installation of the library. 
 
   Activities other than copying, distribution and modification are not 
 covered by this License; they are outside its scope.  The act of 
 running a program using the Library is not restricted, and output from 
 such a program is covered only if its contents constitute a work based 
 on the Library (independent of the use of the Library in a tool for 
 writing it).  Whether that is true depends on what the Library does 
 and what the program that uses the Library does. 
 
   1. You may copy and distribute verbatim copies of the Library's 
 complete source code as you receive it, in any medium, provided that 
 you conspicuously and appropriately publish on each copy an 
 appropriate copyright notice and disclaimer of warranty; keep intact 
 all the notices that refer to this License and to the absence of any 
 warranty; and distribute a copy of this License along with the 
 Library. 
 
   You may charge a fee for the physical act of transferring a copy, 
 and you may at your option offer warranty protection in exchange for a 
 fee. 
  
   2. You may modify your copy or copies of the Library or any portion 
 of it, thus forming a work based on the Library, and copy and 
 distribute such modifications or work under the terms of Section 1 
 above, provided that you also meet all of these conditions: 
 
     a) The modified work must itself be a software library. 
 
     b) You must cause the files modified to carry prominent notices 
     stating that you changed the files and the date of any change. 
 
     c) You must cause the whole of the work to be licensed at no 
     charge to all third parties under the terms of this License. 
 
     d) If a facility in the modified Library refers to a function or a 
     table of data to be supplied by an application program that uses 
     the facility, other than as an argument passed when the facility 
     is invoked, then you must make a good faith effort to ensure that, 
     in the event an application does not supply such function or 
     table, the facility still operates, and performs whatever part of 
     its purpose remains meaningful. 
 
     (For example, a function in a library to compute square roots has 
     a purpose that is entirely well-defined independent of the 
     application.  Therefore, Subsection 2d requires that any 
     application-supplied function or table used by this function must 
     be optional: if the application does not supply it, the square 
     root function must still compute square roots.) 
 
 These requirements apply to the modified work as a whole.  If 
 identifiable sections of that work are not derived from the Library, 
 and can be reasonably considered independent and separate works in 
 themselves, then this License, and its terms, do not apply to those 
 sections when you distribute them as separate works.  But when you 
 distribute the same sections as part of a whole which is a work based 
 on the Library, the distribution of the whole must be on the terms of 
 this License, whose permissions for other licensees extend to the 
 entire whole, and thus to each and every part regardless of who wrote 
 it. 
 
 Thus, it is not the intent of this section to claim rights or contest 
 your rights to work written entirely by you; rather, the intent is to 
 exercise the right to control the distribution of derivative or 
 collective works based on the Library. 
 
 In addition, mere aggregation of another work not based on the Library 
 with the Library (or with a work based on the Library) on a volume of 
 a storage or distribution medium does not bring the other work under 
 the scope of this License. 
 
   3. You may opt to apply the terms of the ordinary GNU General Public 
 License instead of this License to a given copy of the Library.  To do 
 this, you must alter all the notices that refer to this License, so 
 that they refer to the ordinary GNU General Public License, version 2, 
 instead of to this License.  (If a newer version than version 2 of the 
 ordinary GNU General Public License has appeared, then you can specify 
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 that version instead if you wish.)  Do not make any other change in 
 these notices. 
  
   Once this change is made in a given copy, it is irreversible for 
 that copy, so the ordinary GNU General Public License applies to all 
 subsequent copies and derivative works made from that copy. 
 
   This option is useful when you wish to copy part of the code of 
 the Library into a program that is not a library. 
 
   4. You may copy and distribute the Library (or a portion or 
 derivative of it, under Section 2) in object code or executable form 
 under the terms of Sections 1 and 2 above provided that you accompany 
 it with the complete corresponding machine-readable source code, which 
 must be distributed under the terms of Sections 1 and 2 above on a 
 medium customarily used for software interchange. 
 
   If distribution of object code is made by offering access to copy 
 from a designated place, then offering equivalent access to copy the 
 source code from the same place satisfies the requirement to 
 distribute the source code, even though third parties are not 
 compelled to copy the source along with the object code. 
 
   5. A program that contains no derivative of any portion of the 
 Library, but is designed to work with the Library by being compiled or 
 linked with it, is called a "work that uses the Library".  Such a 
 work, in isolation, is not a derivative work of the Library, and 
 therefore falls outside the scope of this License. 
 
   However, linking a "work that uses the Library" with the Library 
 creates an executable that is a derivative of the Library (because it 
 contains portions of the Library), rather than a "work that uses the 
 library".  The executable is therefore covered by this License. 
 Section 6 states terms for distribution of such executables. 
 
   When a "work that uses the Library" uses material from a header file 
 that is part of the Library, the object code for the work may be a 
 derivative work of the Library even though the source code is not. 
 Whether this is true is especially significant if the work can be 
 linked without the Library, or if the work is itself a library.  The 
 threshold for this to be true is not precisely defined by law. 
 
   If such an object file uses only numerical parameters, data 
 structure layouts and accessors, and small macros and small inline 
 functions (ten lines or less in length), then the use of the object 
 file is unrestricted, regardless of whether it is legally a derivative 
 work.  (Executables containing this object code plus portions of the 
 Library will still fall under Section 6.) 
 
   Otherwise, if the work is a derivative of the Library, you may 
 distribute the object code for the work under the terms of Section 6. 
 Any executables containing that work also fall under Section 6, 
 whether or not they are linked directly with the Library itself. 
  
   6. As an exception to the Sections above, you may also combine or 
 link a "work that uses the Library" with the Library to produce a 
 work containing portions of the Library, and distribute that work 
 under terms of your choice, provided that the terms permit 
 modification of the work for the customer's own use and reverse 
 engineering for debugging such modifications. 
 
   You must give prominent notice with each copy of the work that the 
 Library is used in it and that the Library and its use are covered by 
 this License.  You must supply a copy of this License.  If the work 
 during execution displays copyright notices, you must include the 
 copyright notice for the Library among them, as well as a reference 
 directing the user to the copy of this License.  Also, you must do one 
 of these things: 
 
     a) Accompany the work with the complete corresponding 
     machine-readable source code for the Library including whatever 
     changes were used in the work (which must be distributed under 
     Sections 1 and 2 above); and, if the work is an executable linked 
     with the Library, with the complete machine-readable "work that 
     uses the Library", as object code and/or source code, so that the 
     user can modify the Library and then relink to produce a modified 
     executable containing the modified Library.  (It is understood 
     that the user who changes the contents of definitions files in the 
     Library will not necessarily be able to recompile the application 
     to use the modified definitions.) 
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     b) Use a suitable shared library mechanism for linking with the 
     Library.  A suitable mechanism is one that (1) uses at run time a 
     copy of the library already present on the user's computer system, 
     rather than copying library functions into the executable, and (2) 
     will operate properly with a modified version of the library, if 
     the user installs one, as long as the modified version is 
     interface-compatible with the version that the work was made with. 
 
     c) Accompany the work with a written offer, valid for at 
     least three years, to give the same user the materials 
     specified in Subsection 6a, above, for a charge no more 
     than the cost of performing this distribution. 
 
     d) If distribution of the work is made by offering access to copy 
     from a designated place, offer equivalent access to copy the above 
     specified materials from the same place. 
 
     e) Verify that the user has already received a copy of these 
     materials or that you have already sent this user a copy. 
 
   For an executable, the required form of the "work that uses the 
 Library" must include any data and utility programs needed for 
 reproducing the executable from it.  However, as a special exception, 
 the materials to be distributed need not include anything that is 
 normally distributed (in either source or binary form) with the major 
 components (compiler, kernel, and so on) of the operating system on 
 which the executable runs, unless that component itself accompanies 
 the executable. 
 
   It may happen that this requirement contradicts the license 
 restrictions of other proprietary libraries that do not normally 
 accompany the operating system.  Such a contradiction means you cannot 
 use both them and the Library together in an executable that you 
 distribute. 
  
   7. You may place library facilities that are a work based on the 
 Library side-by-side in a single library together with other library 
 facilities not covered by this License, and distribute such a combined 
 library, provided that the separate distribution of the work based on 
 the Library and of the other library facilities is otherwise 
 permitted, and provided that you do these two things: 
 
     a) Accompany the combined library with a copy of the same work 
     based on the Library, uncombined with any other library 
     facilities.  This must be distributed under the terms of the 
     Sections above. 
 
     b) Give prominent notice with the combined library of the fact 
     that part of it is a work based on the Library, and explaining 
     where to find the accompanying uncombined form of the same work. 
 
   8. You may not copy, modify, sublicense, link with, or distribute 
 the Library except as expressly provided under this License.  Any 
 attempt otherwise to copy, modify, sublicense, link with, or 
 distribute the Library is void, and will automatically terminate your 
 rights under this License.  However, parties who have received copies, 
 or rights, from you under this License will not have their licenses 
 terminated so long as such parties remain in full compliance. 
 
   9. You are not required to accept this License, since you have not 
 signed it.  However, nothing else grants you permission to modify or 
 distribute the Library or its derivative works.  These actions are 
 prohibited by law if you do not accept this License.  Therefore, by 
 modifying or distributing the Library (or any work based on the 
 Library), you indicate your acceptance of this License to do so, and 
 all its terms and conditions for copying, distributing or modifying 
 the Library or works based on it. 
 
   10. Each time you redistribute the Library (or any work based on the 
 Library), the recipient automatically receives a license from the 
 original licensor to copy, distribute, link with or modify the Library 
 subject to these terms and conditions.  You may not impose any further 
 restrictions on the recipients' exercise of the rights granted herein. 
 You are not responsible for enforcing compliance by third parties with 
 this License. 
  
   11. If, as a consequence of a court judgment or allegation of patent 
 infringement or for any other reason (not limited to patent issues), 
 conditions are imposed on you (whether by court order, agreement or 
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 otherwise) that contradict the conditions of this License, they do not 
 excuse you from the conditions of this License.  If you cannot 
 distribute so as to satisfy simultaneously your obligations under this 
 License and any other pertinent obligations, then as a consequence you 
 may not distribute the Library at all.  For example, if a patent 
 license would not permit royalty-free redistribution of the Library by 
 all those who receive copies directly or indirectly through you, then 
 the only way you could satisfy both it and this License would be to 
 refrain entirely from distribution of the Library. 
 
 If any portion of this section is held invalid or unenforceable under any 
 particular circumstance, the balance of the section is intended to apply, 
 and the section as a whole is intended to apply in other circumstances. 
 
 It is not the purpose of this section to induce you to infringe any 
 patents or other property right claims or to contest validity of any 
 such claims; this section has the sole purpose of protecting the 
 integrity of the free software distribution system which is 
 implemented by public license practices.  Many people have made 
 generous contributions to the wide range of software distributed 
 through that system in reliance on consistent application of that 
 system; it is up to the author/donor to decide if he or she is willing 
 to distribute software through any other system and a licensee cannot 
 impose that choice. 
 
 This section is intended to make thoroughly clear what is believed to 
 be a consequence of the rest of this License. 
 
   12. If the distribution and/or use of the Library is restricted in 
 certain countries either by patents or by copyrighted interfaces, the 
 original copyright holder who places the Library under this License may add 
 an explicit geographical distribution limitation excluding those countries, 
 so that distribution is permitted only in or among countries not thus 
 excluded.  In such case, this License incorporates the limitation as if 
 written in the body of this License. 
 
   13. The Free Software Foundation may publish revised and/or new 
 versions of the Lesser General Public License from time to time. 
 Such new versions will be similar in spirit to the present version, 
 but may differ in detail to address new problems or concerns. 
 
 Each version is given a distinguishing version number.  If the Library 
 specifies a version number of this License which applies to it and 
 "any later version", you have the option of following the terms and 
 conditions either of that version or of any later version published by 
 the Free Software Foundation.  If the Library does not specify a 
 license version number, you may choose any version ever published by 
 the Free Software Foundation. 
  
   14. If you wish to incorporate parts of the Library into other free 
 programs whose distribution conditions are incompatible with these, 
 write to the author to ask for permission.  For software which is 
 copyrighted by the Free Software Foundation, write to the Free 
 Software Foundation; we sometimes make exceptions for this.  Our 
 decision will be guided by the two goals of preserving the free status 
 of all derivatives of our free software and of promoting the sharing 
 and reuse of software generally. 
 
                             NO WARRANTY 
 
   15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
 WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW. 
 EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
 OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY 
 KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
 IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
 PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
 LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME 
 THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
 
   16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
 WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY 
 AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU 
 FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
 CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
 LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
 RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A 
 FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF 
 SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
 DAMAGES. 
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                      END OF TERMS AND CONDITIONS 
  
            How to Apply These Terms to Your New Libraries 
 
   If you develop a new library, and you want it to be of the greatest 
 possible use to the public, we recommend making it free software that 
 everyone can redistribute and change.  You can do so by permitting 
 redistribution under these terms (or, alternatively, under the terms of the 
 ordinary General Public License). 
 
   To apply these terms, attach the following notices to the library.  It is 
 safest to attach them to the start of each source file to most effectively 
 convey the exclusion of warranty; and each file should have at least the 
 "copyright" line and a pointer to where the full notice is found. 
 
     <one line to give the library's name and a brief idea of what it does.> 
     Copyright (C) <year>  <name of author> 
 
     This library is free software; you can redistribute it and/or 
     modify it under the terms of the GNU Lesser General Public 
     License as published by the Free Software Foundation; either 
     version 2.1 of the License, or (at your option) any later version. 
 
     This library is distributed in the hope that it will be useful, 
     but WITHOUT ANY WARRANTY; without even the implied warranty of 
     MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU 
     Lesser General Public License for more details. 
 
     You should have received a copy of the GNU Lesser General Public 
     License along with this library; if not, write to the Free Software 
     Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA 
 
 Also add information on how to contact you by electronic and paper mail. 
 
 You should also get your employer (if you work as a programmer) or your 
 school, if any, to sign a "copyright disclaimer" for the library, if 
 necessary.  Here is a sample; alter the names: 
 
   Yoyodyne, Inc., hereby disclaims all copyright interest in the 
   library `Frob' (a library for tweaking knobs) written by James Random Hacker. 
 
   <signature of Ty Coon>, 1 April 1990 
   Ty Coon, President of Vice 
 
 That's all there is to it! 
 
Nokia Qt LGPL Exception version 1.0 
As a special exception to the GNU Lesser General Public License version 2.1, the object code form of 
a "work that uses the Library" may incorporate material from a header file that is part of the 
Library. You may distribute such object code under terms of your choice, provided that the 
incorporated material (i) does not exceed more than 5% of the total size of the Library; and (ii) is 
limited to numerical parameters, data structure layouts, accessors, macros, inline functions and 
templates. 
 
 
Other Licenses Used in Qt 
 
Qt contains some code that is not provided under the the GNU General Public License (GPL), GNU 
Lesser General Public License (LGPL) or the Qt Commercial License Agreement, but rather under 
specific licenses from the original authors. Some pieces of code were developed by Qt Software and 
others originated from third parties. This page lists the licenses used, names the authors, and 
links to the places where it is used. 
Nokia gratefully acknowledges these and other contributions to Qt. We recommend that programs that 
use Qt also acknowledge these contributions, and quote these license statements in an appendix to 
the documentation. 
 
 
OpenGL is a trademark of Silicon Graphics, Inc. in the United States and other countries. 
QGLFormat 
 
WebKit is licensed under the GNU Library General Public License. Individual contributor names and 
copyright dates can be found inline in the code. 
This library is free software; you can redistribute it and/or modify it under the terms of the GNU 
Library General Public License as published by the Free Software Foundation; either version 2 of the 
License, or (at your option) any later version. 
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU 
Library General Public License for more details. 
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You should have received a copy of the GNU Library General Public License along with this library; 
see the file COPYING.LIB. If not, write to the Free Software Foundation, Inc., 51 Franklin Street, 
Fifth Floor, Boston, MA 02110-1301, USA. 
QtWebKit Module 
 
Copyright (C) 1999 Serika Kurusugawa. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS". ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
Shift-JIS Text Codec 
ISO 2022-JP (JIS) Text Codec 
EUC-JP Text Codec 
 
Copyright (C) 1999-2000 Mizi Research Inc. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
EUC-KR Text Codec 
 
Copyright (C) 2000 TurboLinux, Inc. Written by Justin Yu and Sean Chen.  
Copyright (C) 2001, 2002 Turbolinux, Inc. Written by James Su.  
Copyright (C) 2001, 2002 ThizLinux Laboratory Ltd. Written by Anthony Fok. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
GBK Text Codec 
 
Copyright (C) 2000 Ming-Che Chuang  
Copyright (C) 2001, 2002 James Su, Turbolinux Inc.  
Copyright (C) 2002 WU Yi, HancomLinux Inc.  
Copyright (C) 2001, 2002 Anthony Fok, ThizLinux Laboratory Ltd. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
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OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
Big5-HKSCS Text Codec 
 
Copyright (C) 2000 Ming-Che Chuang  
Copyright (C) 2002 James Su, Turbolinux Inc.  
Copyright (C) 2002 Anthony Fok, ThizLinux Laboratory Ltd. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
Big5 Text Codec 
 
Copyright (C) 2003-2004 immodule for Qt Project. All rights reserved. 
This file is written to contribute to Nokia Corporation and/or its subsidiary(-ies) under their own 
license. You may use this file under your Qt license. Following description is copied from their 
original file headers. Contact immodule-qt@freedesktop.org if any conditions of this licensing are 
not clear to you. 
QInputContextFactory 
QInputContextPlugin 
QInputContext 
 
Copyright (C) 2003-2006 Ben van Klinken and the CLucene Team  
Changes are Copyright (C) 2009 Nokia Corporation and/or its subsidiary(-ies). 
This library is free software; you can redistribute it and/or modify it under the terms of the GNU 
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of 
the License, or (at your option) any later version. 
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser 
General Public License for more details. 
You should have received a copy of the GNU Lesser General Public License along with this library; if 
not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA 
QtHelp Module 
 
Copyright (C) 2004, 2005 Daniel M. Duley 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
QImage 
 
Copyright (C) 2007-2008, Apple, Inc. 
All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
Neither the name of Apple, Inc. nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission. 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
Contributions to the Following QtGui Files: qapplication_cocoa_p.h, qapplication_mac.mm, 
qdesktopwidget_mac.mm qeventdispatcher_mac.mm qeventdispatcher_mac_p.h qmacincludes_mac.h 
qt_cocoa_helpers.mm qt_cocoa_helpers_p.h qwidget_mac.mm qsystemtrayicon_mac.mm 
 
Copyright (C) 2009 Nokia Corporation and/or its subsidiary(-ies).  
Copyright (C) 2005 Bjoern Bergstroem 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, modify, market, reproduce, grant sublicenses and 
distribute subject to the following conditions: The above copyright notice and this permission 
notice shall be included in all copies or substantial portions of the Software. These files are 
provided AS IS with NO WARRANTY OF ANY KIND, INCLUDING THE WARRANTY OF DESIGN, MERCHANTIBILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 
Implementation of the Recursive Shadow Casting Algorithm in Qt Designer 
 
Copyright (C) 2009 Nokia Corporation and/or its subsidiary(-ies).  
Copyright (C) 2005 Roberto Raggi 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, modify, market, reproduce, grant sublicenses and 
distribute subject to the following conditions: The above copyright notice and this permission 
notice shall be included in all copies or substantial portions of the Software. These files are 
provided AS IS with NO WARRANTY OF ANY KIND, INCLUDING THE WARRANTY OF DESIGN, MERCHANTIBILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 
Contributions to the Following qt3to4 Files: treewalker.h, treedump.cpp, treedump.h, treewalker.cpp 
 
Copyright (C) The Internet Society (2001). All Rights Reserved. 
This document and translations of it may be copied and furnished to others, and derivative works 
that comment on or otherwise explain it or assist in its implementation may be prepared, copied, 
published and distributed, in whole or in part, without restriction of any kind, provided that the 
above copyright notice and this paragraph are included on all such copies and derivative works. 
However, this document itself may not be modified in any way, such as by removing the copyright 
notice or references to the Internet Society or other Internet organizations, except as needed for 
the purpose of developing Internet standards in which case the procedures for copyrights defined in 
the Internet Standards process must be followed, or as required to translate it into languages other 
than English. 
The limited permissions granted above are perpetual and will not be revoked by the Internet Society 
or its successors or assigns. 
This document and the information contained herein is provided on an "AS IS" basis and THE INTERNET 
SOCIETY AND THE INTERNET ENGINEERING TASK FORCE DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO ANY WARRANTY THAT THE USE OF THE INFORMATION HEREIN WILL NOT INFRINGE 
ANY RIGHTS OR ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Torrent Example 
 
Copyright (c) 1987 X Consortium 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 
The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE X CONSORTIUM BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
Except as contained in this notice, the name of the X Consortium shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization from the X Consortium. 
QRegion 
 
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 
Redistribution and use in source and binary forms are permitted provided that the above copyright 
notice and this paragraph are duplicated in all such forms and that any documentation, advertising 
materials, and other materials related to such distribution and use acknowledge that the software 
was developed by the University of California, Berkeley. The name of the University may not be used 
to endorse or promote products derived from this software without specific prior written permission. 
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT 
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
QDate::weekNumber() 
 
Copyright (c) 1991 by AT&T. 
Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby 
granted, provided that this entire notice is included in all copies of any software which is or 
includes a copy or modification of this software and in all copies of the supporting documentation 
for such software. 
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THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. 
This product includes software developed by the University of California, Berkeley and its 
contributors. 
QLocale's data is based on Common Locale Data Repository v1.6.1. 
QLocale 
 
Copyright (c) 2000 Hans Petter Bieker. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
TSCII Text Codec 
 
Copyright (c) 2003, 2006 Matteo Frigo 
Copyright (c) 2003, 2006 Massachusetts Institute of Technology 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 
The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
QTestLib Manual 
 
Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies). 
All rights reserved. 
Contact: Qt Software Information (qt-info@nokia.com) 
You may use this file under the terms of the BSD license as follows: 
"Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 
* Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
* Neither the name of Nokia Corporation and its Subsidiary(-ies) nor the names of its contributors 
may be used to endorse or promote products derived from this software without specific prior written 
permission. 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE." 
The qtmain Library 
QAxContainer Module 
QAxServer Module 
 
Copyright 1996 Daniel Dardailler. 
Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby 
granted without fee, provided that the above copyright notice appear in all copies and that both 
that copyright notice and this permission notice appear in supporting documentation, and that the 
name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the 
software without specific, written prior permission. Daniel Dardailler makes no representations 
about the suitability of this software for any purpose. It is provided "as is" without express or 
implied warranty. 
Modifications Copyright 1999 Matt Koss, under the same license as above. 
Drag and Drop 
 
Copyright 2002 USC/Information Sciences Institute 
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Permission to use, copy, modify, distribute, and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all copies 
and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Information Sciences Institute not be used in advertising or publicity 
pertaining to distribution of the software without specific, written prior permission. Information 
Sciences Institute makes no representations about the suitability of this software for any purpose. 
It is provided "as is" without express or implied warranty. 
INFORMATION SCIENCES INSTITUTE DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL INFORMATION SCIENCES INSTITUTE 
BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 
QtSvg Module 
 
This file is part of the KDE project 
Copyright (C) 2005-2007 Matthias Kretz <kretz@kde.org>  
Copyright (C) 2009 Nokia Corporation and/or its subsidiary(-ies). Contact: Qt Software Information 
(qt-info@nokia.com) 
This library is free software; you can redistribute it and/or modify it under the terms of the GNU 
Library General Public License version 2 as published by the Free Software Foundation. 
This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without 
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU 
Library General Public License for more details. 
You should have received a copy of the GNU Library General Public License along with this library; 
see the file COPYING.LIB. If not, write to the Free Software Foundation, Inc., 51 Franklin Street, 
Fifth Floor, Boston, MA 02110-1301, USA. 
Phonon Module 
 
Copyright (C) 2000-2004, International Business Machines 
Corporation and others. All Rights Reserved. 
Copyright (C) 2007 Apple Inc. All rights reserved. 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or 
sell copies of the Software, and to permit persons to whom the Software is furnished to do so, 
provided that the above copyright notice(s) and this permission notice appear in all copies of the 
Software and that both the above copyright notice(s) and this permission notice appear in supporting 
documentation. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN 
THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY 
DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE. 
Except as contained in this notice, the name of a copyright holder shall not be used in advertising 
or otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 
Parts of WebKit used by the QtWebKit module 
 
Copyright (c) 1998 by Bjorn Reese <breese@imada.ou.dk> 
Permission to use, copy, modify, and distribute this software for any purpose with or without fee is 
hereby granted, provided that the above copyright notice and this permission notice appear in all 
copies. 
THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE AUTHORS AND CONTRIBUTORS ACCEPT NO RESPONSIBILITY IN ANY CONCEIVABLE MANNER. 
Parts of the QCrashHandler class 
 
Parts of the FreeType projects have been modified and put into Qt for use in the painting subsystem. 
These files are ftraster.h, ftraster.c, ftgrays.h and ftgrays.c. The following modifications has 
been made to these files: 
Renamed FT_ and ft_ symbols to QT_FT_ and qt_ft_ to avoid name conflicts in qrasterdefs_p.h. 
Removed parts of code not relevant when compiled with _STANDALONE_ defined. 
Changed behavior in ftraster.c to follow X polygon filling rules. 
Implemented support in ftraster.c for winding / odd even polygon fill rules. 
Replaced bitmap generation with span generation in ftraster.c. 
Renamed ftraster.h as qblackraster_p.h. 
Renamed ftraster.c as qblackraster.c. 
Renamed ftgrays.h as qgrayraster_p.h. 
Renamed ftgrays.c as qgrayraster.c. 
See src/3rdparty/freetype/docs/FTL.txt and src/3rdparty/freetype/docs/GPL.txt for license details. 
 
Copyright (c) 1985, 1986, 1987 X Consortium 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 
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The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE X CONSORTIUM BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
Except as contained in this notice, the name of the X Consortium shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization from the X Consortium. 
Parts of the Q3PolygonScanner class used in Qt for Embedded Linux 
 
Copyright 1987 by Digital Equipment Corporation, Maynard, Massachusetts. 
All Rights Reserved 
Permission to use, copy, modify, and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appear in all copies and 
that both that copyright notice and this permission notice appear in supporting documentation, and 
that the name of Digital not be used in advertising or publicity pertaining to distribution of the 
software without specific, written prior permission. 
DIGITAL DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL DIGITAL BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER 
IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE. 
Parts of the Q3PolygonScanner class used in Qt for Embedded Linux 
 
Copyright 1985, 1987, 1998 The Open Group 
Permission to use, copy, modify, distribute, and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all copies 
and that both that copyright notice and this permission notice appear in supporting documentation. 
The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE OPEN GROUP BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 
Except as contained in this notice, the name of The Open Group shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization from The Open Group. 
Parts of the internal QKeyMapper class on X11 platforms 
 
pnmscale.c - read a portable anymap and scale it 
Copyright (C) 1989, 1991 by Jef Poskanzer. 
Permission to use, copy, modify, and distribute this software and its documentation for any purpose 
and without fee is hereby granted, provided that the above copyright notice appear in all copies and 
that both that copyright notice and this permission notice appear in supporting documentation. This 
software is provided "as is" without express or implied warranty. 
Parts of the internal QImageSmoothScaler::scale() function use code based on pnmscale.c by Jef 
Poskanzer. 

 

Change History 
 
2.60 (May 2009)  Added Qt licence details in Acknowledgements 
    Added description of Toggle Read/Unread button 
 
2.66 (August 2010)  Added Clone/Move Up/Down By buttons to filter window 
    Added mention of Pluto CSV import in address book window 
    Removed number of characters for word wrap in options window 
    Changed logo 
 
2.66.6 (February 2011) Added description of option to filter locked messages 
 
 
 
 

 


